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Contacts:

Africa:
Medtronic Africa (Pty) Ltd.
Tel: +27 (0) 11 677 4800

Argentina:

Corpomedica S.A.

Tel: +(11) 48141333

Medtronic Directo 24/7: +0800 333 0752

Australia:
Medtronic Australasia Pty. Ltd.
Tel: 1800 668 670

Azerbaijan:
Isomed
Tel: +994 (12) 464 11 30

Bangladesh:

Sonargaon Healthcare Pvt Ltd.
Mobile: (+91)-9903995417

or (+880)-1714217131

Belarus:
0J0 “bapxuH”
Tel: +375 17 313 0990

Belgié/Belgique:
N.V. Medtronic Belgium S.A.
Tel: 0800-90805

Bosnia and Herzegovina:
Medimpex d.o.o.

Tel: +387 33 476 444

or +387 33 476 400

Fax: +387 33 476 401

or +387 33 432 241

Brasil:

Medtronic Comercial Ltda.

Tel: +(11) 2182-9200

Medtronic Directo 24/7:+0800 773 9200

Bulgaria:
RSR Ltd.
Tel: +359 885 428 900

Canada:
Medtronic of Canada Ltd.
Tel: 1-800-284-4416 (toll free/sans-frais)

Chile:

Medtronic Chile

Tel: +(9) 66 29 7126

Medtronic Directo 24/7:+1 230 020 9750

Medtronic Directo 24/7 (From Santiago): +(2) 595 2942

China:

Medtronic (Shanghai) Ltd.

24 Hour Help (Cell): +86 400-820-1981

24 Hour Help (Landline): +86 800-820-1981

Colombia:

Medtronic Latin America Inc. Sucursal Colombia

Tel: +(1) 742 7300

Medtronic Directo 24/7 (Landline): +01 800 710 2170
Medtronic Directo 24/7 (Cellular): +1 381 4902

Croatia:

Medtronic Adriatic d.o.o.
Tel: +385 1488 11 20
Fax: +385 1 484 40 60

Danmark:
Medtronic Danmark A/S
Tel: +45 32 48 18 00

Deutschland:

Medtronic GmbH
Geschéftsbereich Diabetes
Telefon: +49 2159 8149-370
Telefax: +49 2159 8149-110
24-Stdn-Hotline: 0800 6464633

Eire:
Accu-Science LTD.
Tel: +353 45 433000

Espaia:

Medtronic Ibérica S.A.
Tel: +34 91 62505 42

Fax: +34 91 625 03 90

24 horas: +34 900 120 330

Europe:

Medtronic Europe S.A. Europe, Middle East and Africa
Headquarters

Tel: +41 (0) 21-802-7000

France:
Medtronic France S.A.S.
Tel: +33 (0) 15538 17 00

Hellas:
Medtronic Hellas S.A.
Tel: +30 210677-9099

Hong Kong:

Medtronic International Ltd.

Tel: +852 2919-1300

To order supplies: +852 2919-1322
24-hour helpline: +852 2919-6441

India:

India Medtronic Pvt. Ltd

Tel: (+91)-80-22112245 / 32972359
Mobile: (+91)-9611633007

Indonesia:

Medtronic International Ltd.
Tel: +65 6436 5090

or +65 6436 5000

Israel:
Medtronic World Trade Corporation
Tel: +972 9972 4400

Italia:

Medtronic Italia S.p.A.

Tel: +39 02 24137 261

Fax: +39 02 24138 210
Servizio assistenza tecnica:
Ne verde: 800 60 11 22

Japan:

Medtronic Japan Co. Ltd.

Tel: +81-3-6776-0019

24 Hr. Support Line: 0120-56-32-56

Kazakhstan:

Medtronic BV in Kazakhstan

Tel: +7 727 311 05 80 (Almaty)

Tel: +7 717 224 48 11 (Astana)

KpyrnocytouHasa nuHua noanepxku: 8 800 080 5001

Latin America:
Medtronic, Inc.
Tel: 1(305) 500-9328
Fax: 1(786) 709-4244
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Latvija:
Ravemma Ltd.
Tel: +371 7273780

Macedonia:
Alkaloid Kons Dooel
Tel: +389 2 3204 430

Magyarorszag:
Medtronic Hungaria Kft.
Tel: +36 1 889 0688

Malaysia:
Medtronic International Ltd.
Tel: +603 7946 9000

Middle East and North Africa:
Regional Office
Tel: +961-1-370 670

Montenegro:

Glosarij

Tel: +382 20 642 495

Fax: +382 20 642 540

México:

Medtronic Servicios S. de R. L. de C.V.

Tel (México DF): +(11) 029 058

Tel (Interior): +01 800 000 7867
Medtronic Directo 24/7 (from México DF):
+(55) 36 869 787

Medtronic Directo 24/7:+01 800 681 1845

Nederland, Luxembourg:
Medtronic B.V.

Tel: +31 (0) 45-566-8291
Gratis: 0800-3422338

New Zealand:

Medica Pacifica

Phone: 64 94140318
Free Phone: 0800 106 100

Norge:

Medtronic Norge A/S
Tel: +47 67 10 32 00
Fax: +47 67 103210

Philippines:

Medtronic International Ltd.
Tel: +65 6436 5090

or +65 6436 5000

Poccusa:

000 «MeaTPOHUK»

Tel: +7 495 58073 77

KpyrnocytouHas nuHua nopgepxku: 8 800 200 76 36

Polska:
Medtronic Poland Sp. z 0.0.
Tel: +48 22 465 6934

Portugal:

Medtronic Portugal Lda
Tel: +351 21 7245100
Fax:+351 217245199

Puerto Rico:
Medtronic Puerto Rico
Tel: 787-753-5270

Republic of Korea:
Medtronic Korea, Co., Ltd.
Tel: +82.2.3404.3600

Romania:
Medtronic BV Reprezentanta
Tel: +40 372 188 000

Schweiz:

Medtronic (Schweiz) AG

Tel: +41 (0)31 868 0160
24-Stunden-Hotline: 0800 633333
Fax Allgemein: +41 (0)318680199

Serbia:
Medtronic B.V. Serbia
Tel: +381 11 2095 900

Singapore:

Medtronic International Ltd.
Tel: +65 6436 5090

or +65 6436 5000

Slovenija:

Zaloker & Zaloker d.o.o.
brezpla¢na Stevilka: 080 1880
Tel: +386 154251 11

Slovenska republika:
Medtronic Slovakia, s.r.o.
Tel: +421 26820 6942
HelpLine: +421 26820 6986

Sri Lanka:

Swiss Biogenics Ltd.
Mobile: (+91)-9003077499
or (+94)-777256760

Suomi:

Medtronic Finland Oy

Tel: +358 20 7281 200

Help line: +358 400 100 313

Sverige:

Medtronic AB

Tel: +46 8 568 585 20
Fax: +46 8 568 585 11

Taiwan:

Medtronic (Taiwan) Ltd.
Tel: 02-21836000

Toll free: +886-800-005285

Thailand:
Medtronic (Thailand) Ltd.
Tel: +662 232 7400

Tirkiye:

Medtronic Medikal Teknoloji
Ticaret Ltd. Sirketi.

Tel: +90 216 4694330

USA:

Medtronic Diabetes Global Headquarters
24 Hour HelpLine: +1-800-646-4633

To order supplies: +1-800-843-6687

Ukraine:

Medtronic B.V. Representative office in Ukraine
Tel: +38 044 392 04 01

NiHisa yinogo60oBoI NiATPUMKM:

0800 508 300

United Kingdom:
Medtronic Ltd.
Tel: +44 1923-205167

Osterreich:

Medtronic Osterreich GmbH

Tel: +43 (0) 1 240 44-0

24 - Stunden - Hotline: 0820 820 190

Ceska republika:
Medtronic Czechia s.r.o.
Tel: +420 233 059 111
Non-stop helpLine (24/7):
+420 233 059 059

P150029 PMA Final Labeling Amendment
Medtronic Confidential

P150029
1-16



Zékaznicky servis (8:00 - 17:00):
+420 233 059 950
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Introduction

iPro2 system

user safety

%

Welcome to iPro2 Continuous Glucose Monitoring (CGM)
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Thank you for your trust in Medtronic products and services. We hope you will find iPro2 to be the
simplest and most convenient CGM product that you have ever used.

This User Guide provides the information that you need for setting up and using the iPro2 CGM
system, including CareLink iPro Therapy Management Software for Diabetes.

You will find a page like this at the beginning of each chapter. This page gives you a basic
overview of that chapter, and the steps you will take to complete each task.

You will also see a “Key Notes” area on each chapter overview page. These are the important
points for you to remember from that chapter.

iPro2 CGM User Guide  Introduction 1
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iPro2 system

These are the components of the iPro2 CGM system, MMT-7745:

iPro®2 digital recorder, MMT-7741 (iPro2)

The iPro2 collects and stores data from a glucose sensor. The data can be uploaded into CareLink
iPro® Therapy Management Software for Diabetes (CareLink iPro, MMT-7340), to generate reports
and store the data. The iPro2 can collect up to seven 24-hour periods of data, after which it

shuts off automatically.

The iPro2 has an internal green light. ( Pe) ) This light flashes when you connect the iPro2 to an

inserted glucose sensor. It will only flash if the iPro2 detects an adequately hydrated sensor, is

fully charged, and does not already contain any data.

The iPro2 can be used up to 60 times. Keep track of iPro2 uses by entering each use on
the Clinic Equipment Log. Discard the iPro2 after 60 uses. If you continue to use the iPro2
beyond 60 times, the disinfection process may damage the device.

iPro®2 Docking Station, MMT-7742 (Dock)

The Dock has two main functions: charging the iPro2 and uploading data from the iPro2 to
CareLink iPro. The Dock has three lights to provide status information. The white Dock power
light indicates whether power is supplied to the Dock. When you connect the iPro2 to the
Dock, the green charging light and the red warning light indicate the status of the iPro2. If the
green charging light is on, the iPro2 is 100% ready to use.

In this User Guide, you will see the three Dock lights described using the following
conventions. Each light is always either off, on, or flashing.

Yoyt
O
St
Red Warning Light o L Flashing
n

Green Charging Light
White Dock Power Light off

iPro2 CGM User Guide  Introduction 2
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« iPro®2 Dock USB cable (refer to MMT-7747 if re-ordering)

The small end of the Universal Serial Bus (USB) cable connects to the Dock. The other end of
the cable connects to a USB port on a computer, so that you can upload data into CareLink
iPro® and charge the iPro2. You can also connect the USB cable to a wall-powered adapter.

Wall-powered adapter (refer to MMT-7747 if re-ordering)

The wall-powered adapter lets you charge the iPro2 by connecting the Dock to a regular
electrical socket, instead of a computer.

«  Three (3) iPro®2 Cleaning Plugs, MMT-7744 (cleaning plug)

The cleaning plugs provide a watertight seal to protect the connector pins on the iPro2. Always
use a cleaning plug when cleaning and disinfecting the iPro2.

Do not clean the o-rings on the cleaning plug, as this can damage the o-rings.

The cleaning plug can be used to clean the iPro2 30 times. Keep track of cleaning plug uses
and discard the cleaning plug after 30 uses. If you continue to use the cleaning plug beyond
30 times, the iPro2 connector pins could be damaged, because the cleaning plug cannot
continue to provide a watertight seal.

Keep only one unwrapped cleaning plug at hand, so that you can keep track of its use and will

know when to unwrap a new cleaning plug.

To order more cleaning plugs, contact your local representative or call Medtronic Diabetes at
800 843 6687.

You will also need the following:
- Serter, MMT-7510
Enlite® sensor, MMT-7008 (Glucose sensor)
« A computer with Internet access to CareLink iPro, MMT-7340 (http://www.carelinkipro.com)
- Patient Log Sheet
«  Patient Consent Form
«  Patient Instructions Sheet
«  Clinic Equipment Log Sheet
«  Clinic Checklist (for patient setup and for uploading iPro2 data and printing reports)

«  Occlusive adhesive dressing

iPro2 CGM User Guide  Introduction 3
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User safety

This section includes important safety information such as indications, contraindications, warnings,
and precautions.

Lk

Indications for use

The iPro2 Recorder is to be used with either Enlite sensor or Sof-sensor and is intended to
continuously record interstitial glucose levels in persons with diabetes mellitus. This information is
intended to supplement, not replace, blood glucose information obtained using standard home
glucose monitoring devices. The information collected by the iPro2 digital recorder may be uploaded
to a computer (with Internet access) and reviewed by healthcare professionals. The information may
allow identification of patterns of glucose-level excursions above and below a desired range,
facilitating therapy adjustments, which may minimize these excursions.

This iPro2 system:
« is intended for prescription use only.
« does not allow data to be made available directly to patients in real time.

«  provides data that will be available for review by physicians after the recording interval (up to
144 hours).

« is intended for occasional rather than everyday use.

« is to be used only as a supplement to, and not a replacement for, standard invasive

measurement.

Contraindications

None known.

Warnings
«  This product contains small parts and may pose a choking hazard for young children.

«  The glucose sensor should be removed if redness, bleeding, pain, tenderness, irritation, or
inflammation develops at the sensor insertion site, or if the patient experiences unexplained
fever.

iPro2 CGM User Guide  Introduction 4
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«  An optional occlusive adhesive dressing should be removed if irritation or reaction to the tape
develops.

«  The glucose sensor may create special needs regarding your patients' medical conditions or
medications. Bleeding, swelling, irritation or infection at the insertion site are possible risks
associated with inserting the sensor and sometimes result from improper insertion and
maintenance of insertion site. Taking medications with acetaminophen while wearing the sensor
may falsely raise your sensor glucose readings. The level of inaccuracy depends on the amount
of acetaminophen active in your body and may be different for each person. Always use BG
meter readings to verify your glucose level before making therapy decisions. Healthcare
professionals should discuss this with their patients before they use the glucose sensor.

« Do not modify this product, as modification could result in a safety hazard.

«  The iPro2 must be disinfected after every use on a patient. Users must adhere to universal
precautions when handling or using this device to prevent transmission of diseases. For more
information, refer to "Guideline for Isolation Precautions: Preventing Transmission of Infectious
Agents in Healthcare Settings 2007." www.cdc.gov/hicpac/2007ip/
2007isolationprecautions.html. For more information on cleaning and disinfection, see Cleaning
and disinfecting the iPro2 on page 38.

« Do not expose your iPro2 or sensor to Magnetic Resonance Imaging (MRI) equipment, x-ray
equipment, Computed Tomography (CT) scanners, Intensity-Modulated Radiation Therapy
(IMRT), diathermy devices, or other devices that generate strong magnetic fields or ionizing
radiation. This equipment has strong magnetic fields or ionizing radiation that can cause the
device to malfunction If the iPro2 or sensor is inadvertently exposed to a strong magnetic
field, discontinue use and contact the 24 Hour HelpLine for further assistance.

Precautions

«  If performing multiple iPro2 studies on the same patient, establish a rotation schedule for
choosing new sensor sites.

« Avoid inserting a sensor in areas on the body that are constrained by clothing, have scar

tissue, or are subject to rigorous movement during exercise.

«  Before connecting the iPro2, do the following:

- Make sure that the sensor insertion site is not bleeding before connection. If you find blood
on top of the sensor adhesive, do not connect the iPro2. This is to prevent body fluids from
getting into the iPro2 connector opening. If blood gets inside the iPro2's connector
opening, it may not be properly cleaned and disinfected without damaging the connector
pins. So the iPro2 will have to be discarded.

- If bleeding occurs, apply steady pressure with a sterile gauze or cloth at the insertion site
until bleeding stops. After bleeding stops, attach the iPro2 to the sensor.

- If bleeding persists after three minutes, remove the sensor and discard. Insert a new sensor
in a different location.

iPro2 CGM User Guide  Introduction 5
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«  If body fluid comes into contact with the cleaning plug's connector or the Dock's connector,
the contaminated device must be discarded to prevent contamination of the iPro2.

« Do not allow fluids (including water, cleaning fluids, and disinfectants) on the iPro2's connector
opening or connector pins. Fluids can cause the connector pins to corrode and may affect the
iPro2's performance.

iPro2 CGM User Guide  Introduction 6
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Meters supported by CareLink iPro for uploading

Data from the following blood glucose meters can be uploaded to Carelink iPro. You will need a
meter cable as supplied by the meter manufacturer. Meter cables are not supplied as part of the
iPro2 system.

If a patient uses a meter that is not listed here, you can manually enter the BG meter readings into

CarelLink iPro.

. CONTOUR® *

. CONTOUR® NEXT EZ *
. BREEZE® *

. BREEZE® 2 *+

Bayer

. OneTouch® Ultra®

. OneTouch® Ultra®2
LifeScan . OneTouch® UltraLink™
. OneTouch® UltraSmart®
. OneTouch® UltraMini®

Abbott . Abbott MediSense Precision Xtra™ *+

. ACCU-CHEK® Aviva **+

Roche (available in the U.S. and Canada only)
. ACCU-CHEK® Compact Plus *+*

* At the time of this publication, the manufacturer of this device does not provide a USB device driver for uploading
to Windows 7 32-bit, Windows 7 64-bit, Windows 8 32-bit, or Windows 8 64-bit. If your computer is running one of
these operating systems, you can upload this device using the manufacturer's serial cable only.

*+ At the time of this publication, the manufacturer of this device does not provide a USB device driver for
uploading to Windows 8 32-bit, or Windows 8 64-bit. If your computer is running one of these operating systems,
you can upload this device using the manufacturer's serial cable only.

+*+* The manufacturer of this device provides two types of cables: USB and serial. CareLink iPro supports the serial
cable only.

iPro2 CGM User Guide  Introduction 7
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Computer system requirements

Computers running CareLink iPro must have the following software installed.
«  Operating system:
- Microsoft” Windows" XP Professional 32-bit, Service Pack 3
- Microsoft” Windows" XP Home 32-bit, Service Pack 3
- Microsoft” Windows Vista® Business 32-bit or 64-bit, Service Pack 2
- Microsoft” Windows" 7 Ultimate, 32-bit or 64-bit
- Microsoft” Windows™ 8, Windows 8 Pro, and Windows 8 Enterprise, 32-bit and 64-bit, from
the desktop only.

Internet browser:

NOTE: On Windows 8, from the Start screen, click the Desktop tile and make sure you are
viewing the desktop before you open your browser.

- On Windows only: Microsoft” Internet Explorer” 6, 32-bit

- On Windows only: Microsoft” Internet Explorer” 7, 8, 9, 10, and 11 (Windows 7 only), 32-bit
and 64-bit

- Mozilla® Firefox” 7
Oracle Java™ 6 or greater
- Adobe’ Reader 5.0 or greater

«  USB device drivers for meters that use a USB cable to connect to the computer for uploading
data.

For more information, see the instructions provided by the meter manufacturer. The
manufacturer may not provide drivers for all operating systems that CareLink iPro supports, such
as Windows Vista, Windows 7, and Windows 8, 64-bit.

CareLink iPro does not support USB uploads for all meters. See Meters supported by CareLink iPro
for uploading on page 7 for details.

Computers running CareLink iPro must also be compliant with IEC 60950-1 or an equivalent safety
standard.

Compliance information

The iPro2 and Dock comply with the United States Federal Communications Commission (FCC) and
international standards for Electromagnetic Compatibility. For the specific regulations and test results

for your area, please contact your local representative.

These devices comply with Part 15 of the FCC Rules. Operation is subject to the following two
conditions:

iPro2 CGM User Guide  Introduction 8
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1 These devices may not cause harmful interference.

2 These devices must accept any interference received, including interference that may cause

undesirable operation.

These standards are designed to provide reasonable protection against excessive radio frequency
interference and prevent undesirable operation of the device from unwanted electromagnetic

interference.

iPro2 CGM User Guide  Introduction 9

P150029 PMA Final Labeling Amendment P150029
Medtronic Confidential 1-31



Interference from wireless devices

Common wireless consumer devices, such as cellular (mobile) phones or cordless phones, may
disrupt communication during iPro2 uploads to the computer. It is likely that other wireless devices
using similar frequency ranges will have a similar effect. This interference, however, will not cause
any incorrect data to be sent, and will not cause any harm to your iPro2 system.

To reduce the likelihood of data communication errors, you should relocate either the wireless device
or the iPro2 system devices. Testing conducted with several different cellular phones suggests that
interference will not be a problem if the phone is at least 12 inches (30 centimeters) from the iPro2
system devices. Please keep your mobile device no closer than 12 inches from your iPro2 device.
Please note that mobile devices kept on your belt or in your pocket may be closer than 12 inches
from the iPro2 device and may cause interference.

Assistance

U

If you need help, contact one of the following resources:

24 Hour HelpLine, Advanced Software Support 800 646 4633
Monday through Friday, 5 a.m. to 5 p.m. (PST) 818 576 5555
Medtronic Diabetes Web site www.medtronicdiabetes.com
iPro2 CGM User Guide  Introduction 10
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One-time device setup

activate iPro2

T TIrrrnnnneE

Key Notes:

The reset button on the Dock is used to wake up (or activate) the iPro2 because it is shipped
in a special sleep mode. This is a one-time task. In the future, doing this will erase all sensor
data that is on the iPro2.

Never connect an iPro2 to any device other than the Dock, sensor, or cleaning plug.

«  For cleaning, use only the cleaning plug.

iPro2 CGM User Guide ~ One-time device setup 11
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One-time iPro2 activation

The iPro2 is shipped in a special sleep mode to protect its battery. You need to wake it up by
following this one-time procedure. This should be done a minimum of eight hours before your
first iPro2 patient setup.

CAUTION: Do not perform this procedure if you already have sensor data on the iPro2. If you
press the reset button while the iPro2 is connected to the Dock, all sensor data on the iPro2
will be erased. This procedure is only for activating the iPro2 for the first time.

1 Connect the small end of the USB cable to the Dock.

2 Connect the other end of the USB cable to the wall-powered adapter.

3 Connect the wall-powered adapter into an electrical socket. The three lights on the Dock will
flash once, and then the white Dock power light will remain on, indicating that the Dock is
plugged in.
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4 Place the iPro2 into the Dock.

|
The green charging light will start flashing. ‘@'
7N

NOTE: The red warning light may turn on if you do not immediately complete the next
steps. This is normal because the iPro2 has not been activated. You can continue to follow
these instructions even if you see the red warning light.

5 Find the small hole on the back of the Dock, next to the USB cable. This is the reset button.

6 Insert the end of a small paper clip into the hole about 1/8 inch (0.30 cm). Push the reset button

once and release. The white Dock power light will flash § (D §. After a few seconds, the green

light on the iPro2 will flash. @

Important: Do not apply excessive pressure, or the reset button may be damaged.

The iPro2 is now activated. It will never return to sleep mode.
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Leave the iPro2 on the Dock to continue charging. During charging, the white Dock power light
will be on, and the green charging light will flash.

N7
S\~
@ < /%\

Allow up to eight (8) hours for the iPro2 to fully charge. Once the iPro2 is charged, the green
charging light on the Dock will stop flashing and will remain on. This means that the iPro2 is
fully charged.

Key notes about iPro2

The reset button on the Dock is used to wake up (or activate) the iPro2 because it is shipped
in a special sleep mode. This is a one-time task. In the future, doing this will erase all sensor
data that is on the iPro2.

Never connect an iPro2 to any device other than the Dock, sensor, or cleaning plug. For
example, never connect the iPro2 to the charger for the MiniLink®, shown here, because any

patient data on the iPro2 could be erased.
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3

One-time CarelLink iPro software and
computer setup

create user
accounts

register clinic create Admin user

Trnnes
TN

4 set clinic report set up each computer
settings for uploading

Key Notes:

Do not connect the Dock to the computer until specifically told to do so in this procedure. If
you connect the Dock before the iPro2 Dock driver is installed, it may prevent the iPro2 Dock

driver from installing properly.

You may need to perform a setup task on each computer that will be used for uploading sensor
data from an iPro2.
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+  Usernames must be unique among all CareLink iPro clinics in the system, not just your clinic.

«  Choose at least two people to be administrative users. One of them should complete the
CareLink iPro setup for the clinic.

Register clinic and create administrative user

When you access Carelink iPro for the first time, you will be guided through a process to register
your clinic and create an administrative user. The administrative user is the person who will
create, add, and delete user accounts for the rest of the clinic's staff.

CAUTION: Choose one person to be the first administrator for your clinic and register your
clinic only once using the Register Clinic link. Do not create more than one clinic account for
your clinic. If each user registers another clinic, then the patient records will be divided into

separate clinic accounts and will not be accessible to all users.

1 On the computer, open your Internet browser and go to http://www.carelinkipro.com.

NOTE: On Windows 8, from the Start screen, click the Desktop tile and make sure you are
viewing the desktop before you open your browser.

If you have any trouble accessing the CarelLink iPro web site, check your web browser settings
to verify that JavaScript and SSL 3.0 are enabled. See Required Internet browser settings on
page 22 for additional information. If you still cannot access the web site, check with your
network administrator to find out if your Internet access is restricted.

2 If necessary, click Change country/language, and follow the on-screen instructions.

3 Click the Register Clinic link near the bottom of the screen and follow the on-screen
instructions.

4 When prompted, enter the identifying information for your clinic, and click Continue.
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5 When prompted, enter the identifying information for your administrative user account (also
known as Admin), and click Continue.

You will sign in with this Admin user account to create user accounts for other users at the
clinic.

6 Click Finish to return to the Sign-in screen.

Signin
1 Go to http://www.carelinkipro.com. If you just registered the clinic, you will already be at this
web site.

2 Enter your username and password, and click Sign in.

The Home tab for your clinic appears. The clinic name will be at the top of the screen. Your
clinic’s Patient List will be in the middle of the screen, showing one sample patient record. There
will be no other patients listed until you have conducted studies using iPro2.

If you want to sign out of CareLink iPro, click Sign out near the top right corner of your screen.

Create user accounts

Each staff member who might upload data from an iPro2 or a blood glucose meter, enter Logbook

data, or review or print reports, will need a CareLink iPro user account.

Any user with administrative privileges, also known as an Admin user, can add and delete user
accounts. An Admin user can also access a user account to change the password or other

information in the user account.
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It is a good idea to give administrative privileges to at least two users. Having two Admin users
means that the clinic does not have to rely on only one person for things like setting up new user
accounts, or removing users when they no longer need access. As staff changes at a clinic, make
sure that two or more staff members have administrative privileges.

1 Get a list of names and email addresses for staff members who need CareLink iPro user accounts.
2 In the Clinic Settings tab, click Users. The existing user accounts are displayed.
If you are not logged in as an Admin user, you will not see the Users tab.
3 C(lick the Create new user button. The Create New User screen appears.
4 Enter the required information about the user.

5 If you want this user to have permission to manage user accounts, select the Administrative
Privileges check box.

Important: Always make sure that at least two people have administrative privileges. If an

Admin user leaves the clinic, add a new one.

6 Click Save.

NOTE: Usernames must be unique among all CarelLink iPro clinics in the system, not just
your clinic. If the username you entered is not available, the system informs you that you
must try a different username.

7 Make a note of the username and password so that you can provide them to the user. He or
she will need this information to sign in and select a new password.

Repeat this procedure for each user account that you need to create.
Set clinic report settings

The Clinic Report Settings are the default settings for each new patient record. They are like a
template for new patient records.

NOTE: Changing the Clinic Report Settings does not affect any existing patient studies or

reports.
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If a particular patient has unique needs, you will be able to override these settings later for individual
patients as needed.

1 Click the Clinic Settings tab. The Report Settings for the clinic are displayed.

If you do not see the Clinic Settings tab, click the Home tab. You should now see the Clinic
Settings tab.

2 In Report Settings, set the General Report Settings and the Overlay by Meal Report Settings.

For more information about these settings, see the following two sections, or click the help icon

9 in CarelLink iPro for each section.
3 When you are finished, click Save.

The clinic settings take effect for all new patients added to the system after you change the
settings. Previously added patients and previously generated reports are not affected.

For more details about how to set different report settings for a particular patient, see Patient
Report Settings on page 54.

General Report Settings

The General Report Settings determine how glucose and time information will be displayed in
patient reports.

Glucose Target Range fields: Select a glucose target range to use in the reports.
+  Glucose Units: Select the appropriate units for reporting glucose amounts (mg/dL or mmol/L).

Time Display: Select 12 hour or 24 hour time display format.

Overlay by Meal Report Settings

The Glucose Target Range fields specify a Before Meal and After Meal glucose target range for each
of the three meal periods. The overnight periods of Evening and Sleeping contain a single target
range. You may enter a high value and low value for a target range according to the following rules.

« If you have selected mg/dL as the Glucose Units:
- The format for entering the low value for the target range is xxx (for example, 123). The
low value must be at least 40 and must be at least 2 mg/dL below the high value.
- The format for entering the high value for the target range is xxx (for example, 123). The
range can be from 60 to 300.

« If you have selected mmol/L as the Glucose Units:
- The format for entering the low value for the target range is xx.x (for example, 12.3). The
low value must be at least 2.2 and must be at least 0.1 mmol/L below the high value.
- The format for entering the high value for the target range is xx.x (for example, 12.3). The
range can be from 3.3 to 16.6.
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Time periods are used to identify which meal to associate with each meal marker. For example, if

the breakfast time period is set from 6:00 a.m. to 10:00 a.m. and lunch is set from 10:00 a.m. to 3:00
p.m., then a meal marker entered for 9:30 a.m. would be interpreted as a breakfast marker, and a

meal marker entered for 12:30 p.m. would be interpreted as a lunch marker.

The duration of each period must be at least 0.5 hours. The end time of a period can be different
from the start time of the next period, so gaps between periods may exist. The one exception to
this rule is that the end of Evening must be the same as the start of Sleeping.

A post-meal analysis is used to generate statistics from data collected following a meal. The Post-
Meal Analysis window can extend up to 4.0 hours after a meal event. The duration of the analysis
window must be at least 0.5 hours. The start time can range from 0.0 to 3.5 and the end time can
range from 0.5 to 4.0.

Set up computers for uploading

CareLink iPro needs Java and certain hardware drivers to be installed, in order to upload patient
data. You also need Adobe Reader installed in order to view CareLink iPro reports.

Before you begin, please note:

« If you do not have Windows administrative privileges for the computers in the office, you will
not be able to complete this task. Ask a user with Windows administrative privileges, such as
your network administrator, to sign in to each computer to allow the installation of required
software components.

«  You must do this for each computer that may be used to upload sensor data from an iPro2
using the Dock.

«  If the computer is running Windows Vista, Windows 7, or Windows 8, see Required settings for
Windows Vista, Windows 7, or Windows 8 users on page 22 before completing this procedure.
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CAUTION: Do not connect the Dock to the computer until specifically told to do so in this
procedure. If you connect the Dock before the iPro2 Dock driver is installed, you may see the
Windows Found New Hardware Wizard. Close the wizard screen or click Cancel, and do not
follow the instructions in the Wizard. It may prevent the iPro2 Dock driver from installing

properly.

1 Sign in to CareLink iPro.

2 On the Home screen, click Patient, Sample M. in the Patient List. If you already have a list of
patients, type Sample Patient in the Search box to find the sample patient in the Patient
List, and click on it to select it.

3 C(lick Open patient.
A sample patient record is displayed.
4 (lick the Upload iPro2 button.

If you see a message asking if you are sure you want to upload another study for the patient,
click Yes.

If you see a message at any time that you do not have permission to install software, contact
your network administrator.

5 If the computer does not have the necessary version of Java installed, a screen prompting you
to install Java is displayed.
a. Click Download and Install the Java™ Plug-in to continue. The link will navigate to the
Oracle Java web site.
b. Follow the on-screen instructions to install Java. Some operating systems may require that
you have Administrative privileges in order to install the Java plug-in.
¢. If you see any security questions in the information bar (above the Medtronic logo) or
security pop-ups, click Allow or Continue.

Also, check the task bar at the bottom of your screen for new items. The Java installation
pop-up may sometimes be hidden behind your current browser window.

NOTE: In the Java installation screen, you may see a check box asking if you want to install
a toolbar. If you do not want to add any toolbars to your Internet browser, make sure to
de-select that option by clicking the check box.

6 Next, CarelLink iPro will install the SerialPort and Dock USB drivers. Follow the on-screen

instructions to install these components.

After all items have been successfully installed, the CareLink iPro screen will say, Prepare iPro2
Recorder for upload.

a. Connect the iPro2 Dock to the computer using the USB cable.

You should see a small pop-up at the bottom of your screen that says, Medtronic iPro2
Dock. This means that the driver for the Dock is successfully installed.
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b. Click Cancel to cancel the demonstration upload.

7 Verify that Adobe Reader is installed on the computer. If Adobe Reader is not installed, go to
http://www.adobe.com/reader to download and install Adobe Reader, so that you will be able
to open and view reports.

8 C(lick the Home tab to close the sample patient record.
The computer is now ready for you to upload data.

9 Repeat this process on each computer that may be used to upload sensor data from an iPro2
using the Dock. On each computer that will be used to view reports only, make sure that Adobe
Reader is installed.

Required settings for Windows Vista, Windows 7, or Windows 8 users

If your computer is running the Windows Vista, Windows 7, or Windows 8 operating system, there
are some additional steps to follow in order to prepare your computer for uploading device data.

1 Make sure that User Account Control is enabled. By default, User Account Control is already
enabled, so it is likely that you do not have to enable it. For details, please see the Microsoft

documentation.
2 Close Internet Explorer.

3 If you are using the Windows 8 operating system:
a. From the Start screen, click the Desktop tile and make sure you are viewing the desktop.
b. Right-click on the Internet Explorer icon in the task bar.
c. In the menu that appears, right-click again on Internet Explorer.

If you are using the Windows 7 or Windows Vista operating system:
a. Navigate to Start > All Programs.
b. Right-click on the Internet Explorer menu item.

4 Select Run as Administrator.

5 When the User Account Control window is displayed, click Allow or Yes.

NOTE: If you are not logged in as an administrator on your computer, you may be asked to
enter an administrator user's password.

6 The system will now allow software components to be installed. Complete the procedure
described in Set up computers for uploading on page 20.

Required Internet browser settings

On all computers where you plan to use CareLink iPro, your Internet browser (either Internet Explorer
or Firefox) must have the following settings enabled:
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JavaScript

«  Secure Sockets Layer (SSL) version 3.0, with 128-bit encryption

Cookies
«  Applets
ActiveX
Enabling JavaScript

The software uses JavaScript to perform some of its functions. JavaScript is enabled by default for
most Internet browsers. If the JavaScript setting for your Internet browser is disabled, you need to
enable this setting in order to use the system.

Enabling JavaScript in Internet Explorer

Take the following steps if you need to enable JavaScript or want to check the setting.

1 From the Internet Explorer menu options, select Tools > Internet Options. The Internet Options
page is displayed.

2 Click the Security tab. The Security tab page is displayed.

3 Select the Internet icon and click the Custom Level button. The Security Settings page is
displayed.

4 Use the scroll bar on the right of the Settings box to scroll down to Active scripting.
5 Underneath Active scripting, select Enable.

6 Click OK.

Enabling JavaScript in Firefox

Take the following steps if you need to enable JavaScript or want to check the setting.

1 From the Firefox menu options, select Tools > Options. The Options page is displayed.
2 C(Click Content.

3 On the Content page, make sure that Enable JavaScript is selected.

4 C(lick OK.

Secure Sockets Layer (SSL) and encryption

Secure Sockets Layer (SSL) refers to a security protocol designed to protect your Web browser
sessions. The system requires your browser to be enabled for SSL Version 3. It also requires support
for 128-bit SSL encryption.
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The minimum Internet browser version required by the system has 128-bit encryption built in. So,
if you are receiving an error message about your browser configuration, and it shows that you have
an SSL setting of less than 128-bit key, you probably need to upgrade to the latest version of your
browser.

First take the following steps to check the SSL on the current version of your browser and make
sure it is enabled.

Enabling SSL in Internet Explorer

1 From the Internet Explorer menu options, select Help > About Internet Explorer.

2 The amount listed after Cipher Strength is the SSL. If this is less than 128-bit, you need to
upgrade your Internet Explorer. See the procedure that follows.

3 Click OK.

4  After verifying that you have 128-bit encryption, select Tools > Internet Options from the
Internet Explorer menu options.

5 C(lick Advanced.
6 Scroll down the list and make sure that Use SSL 3.0 is selected.
7 Click OK.

Upgrading Internet Explorer

If you need to upgrade your Internet Explorer to the latest version, you can go to the Microsoft
Internet Explorer Web site at http://www.microsoft.com.

Follow the instructions provided by Microsoft to download and install the latest version of Internet
Explorer.

Enabling SSL in Firefox

1 From the Firefox menu options, select Tools > Options. The Options page is displayed.

2 (lick Advanced.

3 On the Advanced page, click the Encryption tab.

4  On the Encryption tab, make sure that Use SSL 3.0 is selected.

5 Click OK.

Upgrading Firefox

If you need to upgrade your Firefox to the latest version, you can go to the Mozilla Web site at
http://www.mozilla.com.

Follow the instructions provided by Mozilla to download and install the latest version of Firefox.
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Download and print resources

After you are finished with setting up CareLink iPro for the clinic, you can click the Resources
hyperlink in CareLink iPro to download document resources such as Patient Log Sheets, Clinic

Equipment Log Sheets, and other useful materials.

For example, you can download a sample Patient Consent Form in Microsoft Word format. This form

allows you to easily create actual Patient Consent Forms that are appropriate for your office.

These resources are free from Medtronic for your use with iPro2. Medtronic may occasionally update

these resources based on feedback from users like you.
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Patient setup

insert sensor

1
Medtronic MiniMed
REF MMT-7741

HEEEEEEE

Key Notes:
«  Use universal precautions when handling the sensor and iPro2.
« Do not use IV Prep prior to sensor insertion. It can damage the sensor.

«  Before setting up any patients on iPro2, make sure that your clinic has completed the one-time
CarelLink iPro software and computer setup instructions in the previous chapter.
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Preparing for study

Before the patient arrives in your office, make sure that all the necessary equipment and supplies

are available and ready.

Materials needed for patient setup:

Cleaning plug

Alcohol swabs
Gloves

Serter

Glucose sensor

Sharps container

iPro2, charged and disinfected. The green charging light on the Dock must be on (not
flashing) before you remove the iPro2 from the Dock.

Patient Log Sheets

Patient Consent Form

Patient Instructions

Clinic Equipment Log

Occlusive adhesive dressing

Optional: Clinic Checklist

NOTE: Use universal precautions when handling the sensor and iPro2.

Wiping the iPro2 with alcohol before a patient study

The iPro2 is intended for multiple patient use and must be properly cleaned and disinfected. The

following steps can only be taken once the iPro2 has been cleaned and disinfected.
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1

3

While wearing gloves, attach the cleaning plug to the iPro2 to make sure that fluids do not
contact the iPro2's connector opening. Fluids can cause the connector pins to corrode and affect

the iPro2's performance.

CAUTION: Do not twist the cleaning plug while it is attached to the iPro2. This will damage
the iPro2.

Wipe the iPro2 with an alcohol swab or rinse with alcohol.

CAUTION: The o-rings on the cleaning plug have lubricant to help make a watertight seal
with the iPro2. This lubricant may wear off after approximately 30 uses. At that time, the
cleaning plug must be discarded. Keep only one unwrapped cleaning plug at hand, so that
you can keep track of its use and will know when to unwrap a new cleaning plug.

Tips for a successful patient study

Keep the sensor hydrated and fully inserted throughout the study:
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- Make sure to follow the sensor insertion instructions carefully.
- Choose a good sensor insertion site.

- Use the proper angle for insertion.

- Apply an adhesive dressing over the sensor and iPro2.

« If you see gaps in sensor data, it could be caused by any of the following reasons:

- The sensor was partially removed during the study, which means that no data was being
collected for that period of time.

- The iPro2 lost its connection with the sensor. If the iPro2 is disconnected from the sensor
and then reconnected during the study, it will continue recording. However, there will be
a gap in the sensor data. The length of the gap depends on how long the iPro2 was
disconnected.

- The sensor was not continuously hydrated while connected to the body. It is possible for
the sensor to lose hydration and then regain it, even if it does not pull out.

- Carelink iPro does not have good BG meter readings within 12 hours of each other to
calibrate all of the sensor data.

«  Emphasize to the patient, ideally by using a Patient Instructions Sheet, the importance of
following instructions for blood glucose testing throughout the study. Patients should complete
at least four BG meter readings per day to avoid data gaps. If a patient does not record
accurate BG meter readings frequently enough, Carelink iPro will not have enough BG meter
readings to fully calibrate the sensor data. This can cause gaps in data on the patient's
reports. CareLink iPro needs at least one BG meter reading within an expected range every 12
hours. Erroneous BG meter readings may be ignored by CareLink iPro and may stop the sensor
plot until the next good BG meter reading.

«  Make sure that your patient tests blood glucose at least one hour after the iPro2 is connected
to the sensor. The iPro2 takes one hour to start up a sensor. If the patient does the first BG
meter reading too soon, sensor data will not be available for calibration. Therefore, the sensor
trace in the reports will begin at the time of the next BG meter reading. This will be apparent
in CareLink iPro reports because the data will begin later than you expect.

«  Make sure that the patient does another BG meter reading two hours after the first one. This
BG meter reading is a backup, in case the first BG meter reading was a few minutes too early.

«  Mid-study upload: Uploading sensor data from an iPro2 clears the data from the iPro2. The first
upload will be shown as its own study in CareLink iPro. When the iPro2 is reconnected to the
sensor, it will begin the one-hour start up again and start a new study, assuming that it also
has enough charge to start a new study. You cannot combine two separate uploads into one
set of reports in CarelLink iPro.

« Do not change the sensor during the study. The iPro2 will keep recording, but the values on
the second sensor will vary widely for many hours because the iPro2 will not properly start the
second sensor. For the best results, upload data after each sensor use.
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Preparation for sensor insertion

1 Ask your patient about sleeping position and about his or her normal daily routine. Does the
patient exercise or do a lot of bending or lifting at work? What kind of clothing does the patient
normally wear? Are there other activities that could disturb a sensor site, such as prolonged
sitting in a driving position in a car? Choose a site that will be protected.

Wash your hands thoroughly.
Put on gloves.

Ask the patient to stand.

i A W N

Clean the insertion site with alcohol and allow to air dry.

/

/
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NOTE: Do not use sticky skin preparation solutions before inserting the sensor. A sticky
intravenous (I.V.) preparation solution may be used after the sensor is inserted, and before
applying an occlusive adhesive dressing, to help the adhesive stick to the patient's skin.

Always refer to the instructions that came with the glucose sensor and the sensor insertion device.

Inserting the sensor

1 Refer to your serter user guide for information on sensor insertion.

CAUTION: If you see body fluid on the metal sensor contacts or black o-rings, do not
connect the iPro2. Remove and dispose of the sensor, and insert a new sensor. This will

prevent contamination of the iPro2.
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2 Make an entry on the Clinic Equipment Log and the Patient Log Sheet. Make sure to write down
the serial number (SN) of the iPro2, the patient’s name or ID, and the date that you placed it

on the patient.

1
Medtronic MiniMed
REF MMT-7741

3 Connect the sensor to the iPro2 recorder.

4  Brief your patient on what to do when he or she goes home.

Briefing the patient

The patient must receive detailed instructions on wearing the sensor and iPro2, study compliance,
meter use and maintaining a log sheet. Ideally, provide the patient with a Patient Log Sheet and a
Patient Instructions Sheet. Go over the items listed on each of the documents and make sure that
your patient understands his or her responsibilities to ensure a successful study.

Key points:
«  Wear the iPro2 continuously while following normal daily activities.

«  Record meals, blood glucose, exercise or strenuous activities, and medications on a Patient Log
Sheet.

«  Keep the Patient Log Sheet accessible at all times so that information can immediately be
written down after each event. Record the time and date within five minutes of each BG meter
reading.

«  Use the same glucose meter and the same lot of strips for the entire study.
« Do not let anyone else use the meter during the study.
« Do not use control solution during the study.

« Do not change any settings on the meter during the study, even if a daylight saving time change

occurs.

- Take at least four blood glucose (BG) meter readings per day, such as before each meal and
before bed.

- Take the first BG meter reading at least one hour after leaving the office, and another about

two hours after the first one.
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«  Only BG values between 40 and 400 mg/dL (2.2 and 22.2 mmol/L) will be used for calibration.
If a meter reading is outside of this range, it does not count, and another BG meter reading will
be needed when the patient's blood glucose is within the range.

CAUTION: The patient must return the iPro2 to the clinic within 10 days of the end of the study.
After 10 days, if the iPro2 is not connected to a powered Dock, the iPro2 battery may lose its
charge, and all data on the iPro2 could be lost. Make sure to schedule the patient's return of
the iPro2 well within this time period.

What to do while briefing the patient

1 Give the patient the materials they need, including at least one Patient Log Sheet and a Patient
Instructions Sheet.

2 On the Patient Log Sheet, write the patient's name, iPro2 serial number, meter brand, meter
ID, and the times for the first two BG meter readings.

3 Make sure that the patient's blood glucose meter has a good battery that will last for the entire
length of the study.

4 Check the date and time on the blood glucose meter.

Meter use

Instruct the patient that BG meter readings are required to calibrate the sensor data, and that for
successful study data, the patient must follow these guidelines for meter use.

First day

The patient must do three blood glucose (BG) meter readings on the first day at these times:

« At least one hour after you connect the iPro2 and the patient leaves the office (but not any
sooner than one hour). Write this time on the front of the Patient Log Sheet.

«  Two hours after the first BG meter reading (three hours after the iPro2 is connected)

«  Once more before midnight

Remaining days

«  For the remaining days of the study, collect at least four BG meter readings per day, preferably
before breakfast, lunch, dinner, and bedtime.

«  The patient should do at least three BG meter readings on the last day before the sensor is
removed.
Care and wearing instructions

The patient can shower and swim without removing the iPro2 or sensor. The iPro2 and sensor are
watertight for up to 30 minutes, up to a depth of 8 feet (2.4 meters). There is no time limit for
swimming on the surface of the water or showering.
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The patient should periodically check the sensor site to ensure that the sensor and iPro2 are tightly
connected, that the sensor is fully inserted and that there is no bleeding or irritation at the sensor

site.
« If the sensor is partly pulled out, attempt to gently push it back into place.

Remove the sensor if there is redness, pain, tenderness, or swelling at the site. The patient
should notify the physician’s office if experiencing any of these symptoms.

Insulin should be injected at least 3 inches (7.5 centimeters) away from the sensor insertion site,
and insulin pump infusion should be at least 2 inches (5 centimeters) from the sensor insertion site.

The iPro2 and sensor must be removed prior to an x-ray, CT scan or MRI.

Make sure that the patient can return the iPro2 to the clinic well within 10 days of the end of the
study. After 10 days, if the iPro2 is not connected to a powered Dock, the iPro2 battery may lose

its charge, and all data on the iPro2 could be lost.

Preparing to connect the iPro2 (after briefing the patient)

1 If bleeding has occurred:
a. Apply steady pressure with a sterile gauze or cloth at the insertion site until bleeding stops.
b. When bleeding stops, attach the iPro2 to the sensor.

CAUTION: If bleeding does NOT stop, do NOT connect the iPro2 to the sensor.

2 If bleeding does not stop after three minutes, do the following:
a. Remove the sensor and discard.
b. Reapply pressure using a sterile gauze or cloth until the bleeding stops.
c. Insert a new sensor in a different location.

Connecting the iPro2 to the sensor

Important: The iPro2 must be fully charged and cleared of data before connecting to a sensor.
You can verify this by connecting the iPro2 to the Dock. When you connect the iPro2 to the
Dock, if the green charging light is on (not flashing), as shown below, the iPro2 is fully ready to
use.

O

If you see a red warning light while the iPro2 is connected to the Dock, do not connect the iPro2

to the sensor. See Troubleshooting reference on page 67.

1 Make sure that the sensor insertion site is not bleeding before connection.
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2
3

Hold the end of the inserted sensor to prevent it from moving during connection.

Hold the iPro2 as shown. The flat side of the iPro2 should face the skin.

Push the iPro2 onto the sensor until the sensor's flexible side arms snap into the notches on
the iPro2. If the iPro2 is properly connected, and if the sensor has had enough time to become
hydrated, within 20 seconds the iPro2's green light will flash six times. The flashing takes about

10 seconds.

If the iPro2's green light flashes, then the sensor is fully hydrated and the iPro2 has successfully
started the study.

If the iPro2's green light does not flash, and the Dock displayed a solid green charging light
before you removed the iPro2 from it, then the sensor is not fully hydrated. You can do

either of the following:
a. Remove the iPro2 from the sensor and then try connecting the iPro2 again. This can be
repeated every five minutes until the sensor is hydrated.
b. Remove the sensor from the patient’s body and insert a sensor in a new site on the
body. Wait for the new sensor to become hydrated before connecting the iPro2 again.
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7 Gently cover the iPro2 with the adhesive tab.

Important: If the sensor is pulled out by more than a millimeter, the iPro2 will stop collecting
data until the sensor is pushed back in place. When the sensor is pushed back in, the iPro2 will
start collecting data 30 minutes later.
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Uploading data to CareLink iPro

1 remove iPro2 and
sensor

Key Notes:

clean and disinfect
iPro2

upload data

(TTTTTIRRREE R

«  Always clean and disinfect the iPro2 as described in Cleaning and disinfecting the iPro2 on

page 38 before connecting it to the Dock. Always discard used gloves immediately after

disinfecting the iPro2. The Dock connector cannot be disinfected.

If you see any body fluid in the iPro2 connector opening, do not connect the iPro2 to the

Dock. Instead, you must discard the iPro2 after disinfecting it as described in Cleaning and

disinfecting the iPro2 on page 38.

Always protect the iPro2's connector pins with a watertight cleaning plug when cleaning and

disinfecting. Replace the cleaning plug after 30 uses to maintain a watertight seal.
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Do not connect more than one Dock or blood glucose meter to the computer at one time. Make
sure that both ends of the Dock USB cable are completely connected.

Before you begin

When the patient returns after wearing the iPro2, you will need the following:

« ltems from patient:
- iPro2 (which has been worn by the patient)
- Patient's blood glucose meter
- Completed Patient Log Sheet(s)

+  Gloves
Access to running water
«  Cleaning plug
Optional: adhesive remover, such as Detachol®
«  ENZOL® Enzymatic Detergent
Soft-bristled brush
«  Bleach (6% sodium hypochlorite)
Gauze pad or cloth
«  70% isopropyl alcohol
Bio-waste container
«  Clinic Equipment Log (if used by your office)
Dock, with the USB cable connected to a computer with Internet access

«  Meter manufacturer's cable

Disconnecting the iPro2 and removing the sensor

Disconnecting the iPro2 from the sensor

1 Put on gloves.

2 Carefully remove any adhesive dressing from the iPro2 and sensor assembly.
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3 Hold iPro2 as shown, and pinch the flexible side arms of the sensor between your thumb and
forefinger. Do not twist the iPro2 relative to the sensor.

4 Gently pull the iPro2 away from the sensor assembly.

Removing the sensor from the patient

While wearing gloves, gently lift the adhesive tape away from the patient’s body to remove the
sensor. Place the sensor in a bio-waste container.

Cleaning and disinfecting the iPro2

The iPro2 is intended for multiple patient use. It is important to always inspect and perform the
entire cleaning and disinfection process between uses. Users must adhere to universal precautions
when handling or using this device. For more information, refer to "Guideline for Isolation
Precautions: Preventing Transmission of Infectious Agents in Healthcare Settings 2007."
www.cdc.gov/hicpac/2007ip/2007isolationprecautions.html. Always inspect, clean, and disinfect the
iPro2 before connecting it to the Dock. The Dock cannot be disinfected. See Warnings for
additional information.

The iPro2 can be used up to 60 times. Keep track of iPro2 uses by entering each use on the Clinic
Equipment Log. Discard the iPro2 after 60 uses. If you continue to use the iPro2 beyond 60 times,
the disinfection process may damage the device.

1 It is strongly recommended to print a copy of the Clinic Checklist to guide you through these
steps. As you complete each step, mark it as complete on the checklist to make sure that you
do not miss any steps.

2  Put on gloves.
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3 Inspect the inside of the connector opening for any sign of body fluid.

CAUTION: The person inspecting the iPro2 must have sufficient vision that enables him or
her to see small drops of body fluid or debris.

WARNING: If you see any body fluid in the connector opening, you must discard the iPro2.
Because the iPro2 contains a battery, do not discard in a bio-waste container. Instead,
continue to clean and disinfect the iPro2, and then discard according to local regulations
for battery disposal (non-incineration).

connector opening

connector pins

housing

Important:

- The cleaning plug is a required component for cleaning and disinfecting. The cleaning plug
ensures that fluids do not contact the iPro2's connector pins. Fluids can cause the connector
pins to corrode and affect the iPro2's performance.

- Do not twist the cleaning plug while it is attached to the iPro2. This will damage the iPro2.

iPro2 CGM User Guide  Uploading data to CareLink iPro 39

P150029 PMA Final Labeling Amendment P150029
Medtronic Confidential 1-61



5

6

If there is adhesive residue on the iPro2, you can remove it with adhesive remover (for
example, Detachol®) between each patient use. Follow adhesive remover manufacturer

instructions.

F

Rinse the iPro2 under cool tap water for at least one minute, or until any visible debris is gone.

Prepare ENZOL® Enzymatic Detergent solution using one ounce of detergent per gallon of water.

NOTE: Cleaning efficacy testing and robustness testing were conducted on the iPro2 using
ENZOL® Enzymatic Detergent. Robustness testing for the iPro2 included a contact time of
one minute per cycle for 61 cycles, which is equivalent to cleaning every three days for six

months.

With the cleaning plug still attached, fully submerge the iPro2 in the detergent solution for at

least one minute.

iPro2 CGM User Guide  Uploading data to CareLink iPro 40

P150029 PMA Final Labeling Amendment P150029
Medtronic Confidential 1-62



9 Holding the cleaning plug, remove the iPro2 from the solution. Brush the entire surface of the
iPro2 using a soft-bristled brush, paying close attention to hard-to-clean areas, until visibly clean.
10 Rinse the iPro2 under cool tap water until any visible detergent is gone.
/8
A
11 Dry any excess moisture by wiping the outside of the iPro2 with a clean, dry cloth.
A
12 Prepare a 1:10 bleach solution by using one (1) part 6% bleach to nine (9) parts water, for a
final concentration of 0.6%. Make sure to prepare a fresh solution for each use.
NOTE: Disinfecting efficacy testing and robustness testing were conducted on the iPro2
using Clorox® Regular Bleach (EPA registration number 5813-50, distributed by The Clorox
Company). Robustness testing for the iPro2 included a contact time of 30 minutes per cycle
for 61 cycles, which is equivalent to cleaning every three days for six months.
13 With cleaning plug still attached, soak the iPro2 in the bleach solution for 30 minutes.
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NOTE: Be sure to set a timer to remove the iPro2 from the bleach solution at 30 minutes.

14 Rinse the iPro2 under cool tap water for at least three minutes.

15 Holding the cleaning plug, wipe the iPro2 with 70% isopropyl alcohol.

16 Important: If you saw any body fluid inside the connector opening on earlier inspection, you
must now discard the iPro2 with cleaning plug still attached, according to local regulations for
battery disposal (non-incineration).

17 Disconnect the cleaning plug from the iPro2 by gently squeezing the arms of the cleaning plug.
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18

19
20

Inspect the housing of the iPro2 for any signs of cracking, flaking, or damage. If you see any of
these signs, you must now discard the disinfected iPro2 according to local regulations for battery
disposal (non-incineration).

WARNING: Cracking, flaking, or damage of the housing are signs of deterioration and the
performance of the device may be compromised. This may affect the ability to properly
clean and disinfect the iPro2. If these signs are noted, the device must be discarded
according to local regulations for battery disposal (non-incineration).

Place the iPro2 on a clean, dry, non-shedding cloth and air dry completely.
Discard used gloves before proceeding.

Proper performance of the iPro2 is indicated by the lights on the Dock. After you finish the
disinfection process, you must upload the patient data as instructed in the following sections.
If you see a red warning light on the Dock after connecting the iPro2, see Troubleshooting
reference on page 67.

Opening the patient record

1 On the computer, open your Internet browser and go to http://www.carelinkipro.com.
2 Sign in to CareLink iPro using your username and password.
If you are already signed in, click the Home tab.
3 Type any of the following into the Search box to find the patient record:
- First name
- Last name
- Patient ID
- Date of birth
As you type, the Patient List displays matching patient records from previous iPro2 studies.
4 When you see the patient in the list, select the patient and click the Open patient button. You
can also double-click the patient in the list.
5 If you do not see the patient in the Patient List, click the New patient button to add the patient
to CarelLink iPro.
The Create new patient record screen is displayed.
CAUTION: Make sure to thoroughly search for the patient in Carelink iPro before adding a
new patient record. If your clinic has already conducted a study for the patient, open the
existing patient record. Avoid creating multiple records for one patient, as this will make
the patient's data more difficult to find in the system.
6 Enter the identifying information for the patient. The patient’s name or patient ID that you enter
will be displayed on reports. Click Save when you are finished.
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You can modify the patient information later by clicking the Edit patient information link on

the patient's record.

Uploading iPro2 data

NOTE: Always navigate using the buttons and links in CarelLink iPro.

1 Verify that the iPro2 you are about to upload is for the patient whose record you are viewing
in CareLink iPro:
a. Find the serial number on the Clinic Equipment Log and on the Patient Log Sheet. These
should match the serial number on the back of the iPro2.
b. On the Clinic Equipment Log, indicate that the iPro2 has been returned.

iPro*
Medtronic MiniMed
REF MMT-7741

CAUTION: Always make sure to verify that you are uploading the correct iPro2.

2 Click the Upload iPro2 button.
3 Follow the on-screen instructions.

If you see a security warning asking if you want to continue, this is asking if you trust that the
content of this system is safe. Your trust is based on the fact that Medtronic MiniMed® has stated
that is safe. Select the check box Always trust content from this publisher, and then click Yes.

4  Make sure that the Dock is connected to the computer by checking both ends of the Dock USB
cable for a complete connection. The white Dock power light @ indicates that it is connected

to a power source such as a computer or wall-powered adapter.
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If you do not see the white Dock power light, the Dock may have insufficient power to
operate. If it is the only device connected, try plugging the Dock into a different USB port
directly on the computer. Not all USB ports may get sufficient power for the Dock to operate.

You can also connect the Dock to the computer using a USB hub. However, if the white Dock
power light does not turn on, then try using a powered USB hub, which has its own electrical
plug that is connected to an electrical socket.

5 When instructed by CarelLink iPro, connect the iPro2 to the Dock.

WARNING: Always inspect the iPro2 connector opening for body fluid. Always clean and
disinfect the iPro2 after removing it from the patient and before attaching it to the Dock.

CAUTION: Do not connect more than one Dock to the computer at one time. Only connect

the iPro2 associated with the opened patient record to the Dock.

The three lights on the Dock will flash once when you connect the iPro2. Then the green
charging light on the Dock will start flashing . This indicates that the iPro2 contains data
1

that needs to be uploaded (or that the iPro2 is charging).

6 Click Continue. CareLink iPro tells you when the upload is successfully completed.

If you see a message that instructs you to see the User Guide, please look up that message in
Troubleshooting reference on page 67.

7 Check the green charging light on the Dock.

iPro2 CGM User Guide  Uploading data to CareLinkiPro 45

P150029 PMA Final Labeling Amendment P150029
Medtronic Confidential 1-67



- If the green charging light on the Dock is on and no longer flashing, the iPro2 is charged

and ready for the next patient.

O

- If the green charging light is still flashing after the upload, leave the iPro2 on the Dock to
charge it, so that it is ready for the next patient.

<

- You can also choose to move the Dock to the wall-powered adapter for charging the
iPro2, or move the iPro2 to another Dock that is connected to a wall-powered adapter, if

you have multiple iPro2 systems.

Uploading blood glucose meter data

If the patient has been using a supported meter (see Meters supported by CarelLink iPro for
uploading on page 7), you can upload meter data directly into CareLink iPro. The software
automatically puts the BG meter readings into the patient’s CarelLink iPro Logbook. If the patient
entered events on the meter, such as meals, medication, exercise, or other, these events will also

be automatically uploaded into the Logbook.

CareLink iPro will compare the time and date of the computer to the time and date of the meter.
If the meter time is incorrect, CareLink iPro will use the computer's time to automatically correct
the BG meter reading times. Do not change the time or date on the meter before uploading.

NOTE: If you have uploaded the iPro2 and there has been a time change, contact the 24 Hour

HelpLine for assistance in uploading the meter.

If the patient has been using a meter that is not listed in Meters supported by Carelink iPro for
uploading on page 7, you can enter BG meter readings manually. See Entering Patient Log Sheet

data on page 47 for instructions.

NOTE: You can upload only one meter per study.

1 If you have just finished uploading the iPro2, you will be prompted to select the patient’s meter

after you click Continue.

You can also choose to enter BG meter readings manually using the Logbook. For details, see
Entering Patient Log Sheet data on page 47.
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2 Follow the on-screen instructions.

3  When prompted, connect the meter to the computer using the appropriate cable (supplied by
the meter manufacturer).

CareLink iPro tells you when the upload is successfully completed.

4 Disconnect the meter from the computer.

Entering Patient Log Sheet data

The Logbook screen in CareLink iPro allows you to manually enter BG meter readings and other
events that the patient recorded on a Patient Log Sheet, such as meals, medication, exercise, or
other.

You can also exclude BG meter readings from being used for sensor calibration, or remove manually
entered events from the patient data if necessary.

Opening the Logbook

If you have just finished uploading the patient’s meter, click Continue to open the Logbook. You
can also open the Logbook by clicking the Open Logbook button found on the patient record

screen.

Adding Logbook entries

CarelLink iPro calibrates the sensor glucose data using the patient’s BG meter readings that are
uploaded or entered manually. If you cannot upload data from the patient’s meter, then you must
enter BG meter readings manually in the Logbook.
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1 Click the Add button. A small window appears, where you can make a Logbook entry.

2 Enter the date and time. If the entry is a BG meter reading, enter the BG value. If the entry is
an event, select the check box for the event.

If the patient recorded more than one entry at the same time, such as a meal and a BG meter
reading, you must enter them both in one entry.

NOTE: If a daylight saving time change occurred during the study, or after the study but
before you are entering the data, enter all log sheet events that occurred before the time
change according to the new time.

3 C(lick Enter. The information goes into the Logbook, but a new empty data entry window stays

open and is ready for the next entry.

4 When you are finished adding Logbook entries, click the X in the upper right corner of the data
entry window to close it.

5 If you are finished using the Logbook, click Continue to return to the patient's main record

screen.

NOTE: Only BG meter readings between 40 and 400 mg/dL (2.2 and 22.2 mmol/L) will be
used for calibration.

Excluding BG meter readings

You can tell CarelLink iPro to exclude a BG meter reading so that it is not used to calibrate the

sensor glucose data.

For example, if the patient allowed a different person to use the meter, or if a control solution
was used but the BG meter reading was not marked as a control reading in the meter, you would
not want these BG meter readings to be used for sensor calibration.

1 In the patient’s Logbook screen, click the Exclude check box for each BG entry that you want
to exclude from the calibration.

2 If you are finished using the Logbook, click Continue to return to the patient’s main record
screen. The reports are regenerated automatically.

When you view the patient’s reports, the BG meter readings that you excluded will not be
shown, and they will not affect the sensor information in the reports.

Editing Logbook entries

You can edit Logbook entries that have been entered manually. Events that were uploaded from
a meter cannot be edited. You can only exclude them from calibration.

1 In the patient’s Logbook screen, click on a Logbook entry to select it, and then click the Edit
button. The Logbook entry opens in a small window.
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2 Edit the information as needed, and click Enter.

3 If you are finished using the Logbook, click Continue to return to the patient’s main record

screen. The reports are regenerated automatically.

Removing Logbook entries

You may sometimes want to remove events from the Logbook so that they do not show up on
the patient’s reports. You can remove Logbook entries that have been entered manually. Events
that were uploaded from a meter cannot be removed. They can only be excluded from
calibration.

1 In the patient’s Logbook screen, click on a Logbook entry to select it, and then click the Remove
button.

2 A small window appears, asking you to confirm that you want to remove the item. Click
Remove. The event no longer appears in the Logbook. When you view the patient’s reports,

the events that you removed will not be shown on the reports.

3 If you are finished using the Logbook, click Continue to return to the patient’s main record
screen. The reports are regenerated automatically.

Sorting the Logbook entries

You can sort the events in the Logbook by clicking on a column heading. This can help you find

items in the Logbook. It does not affect how patient data appears on reports.

You may need to click the column heading twice to reverse the sort order.
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CarelLink iPro reports

viewing and printing reports

maary-—

Key Notes:

«  You can modify a patient's Report Settings, such as the glucose target range and meal
periods, and re-generate reports from a study.

+  Reports show up to seven calendar days of study data.

«  The reports are created in PDF format, so they can easily be stored electronically or printed.
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Viewing and printing patient reports

After uploading and entering all of a patient’s study data into CareLink iPro, you have two options

for viewing the patient’s reports:

View and print the reports individually
Print all reports

If you are not already viewing the patient record, go to the Home tab and use the Search box
to find the patient record.

If you need more instructions on how to find a patient record, see Opening the patient record
on page 43.

On the patient record screen, you can find the dates for all of the studies conducted for this
patient. The most recent study is displayed first. You may need to scroll down to find older
studies.

When you find the study you want, click the name of the report you want to view, or click Print
all to print all three of the main reports.

If you click on a single report, a new window or tab opens in your browser to display the report.

If you click Print all, a new window or tab opens in your browser, with all of the reports in a
single PDF document.

To print, use the print functions that are set up on the computer. For example, you may need
to click a printer icon, or you may need to select File > Print.

Tips for successful report generation

Use the Logbook to exclude BG meter readings that do not accurately reflect the patient's blood

glucose, such as:

- BG meter readings from someone other than the patient

- BG meter readings from a control solution

- BG meter readings that were taken before the patient changed the meter's time or date. If
the patient changed the time on the meter during the study, first exclude all BG meter
readings before the time change. Then, use information from the Patient Log Sheets to
manually enter the BG meter readings at the correct times into the Logbook in CareLink
iPro.

These bad BG meter readings can cause calibration errors, which may result in gaps in the sensor
plot on reports. Excluding these bad BG meter readings will often eliminate data gaps.

Keep in mind that you need BG meter readings within 12 hours of each other in order to avoid
data gaps.
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«  Modify a patient's Report Settings to change the target range for blood glucose, the patient's
meal periods, or other settings.

About reports

CareLink iPro reports show up to seven calendar days of study data. The reports are created in PDF
format, so they can easily be stored electronically or printed. The three main reports are:

- Daily Overlay (one page) - provides an overlay of the sensor traces for each day on a single 24
hour graph, so that you can look for trends or excursions that occur around the same time each
day. This report also provides daily statistical information, including an Excursion Summary of
highs and lows, and Duration Distribution pie charts. The Duration Distribution charts show
what percent of each day the patient spent above, below, and within the target range.

«  Overlay by Meal (two pages) - provides an overlay of the sensor traces from each day of the
study, broken down into meal and overnight periods. The meal overlay graphs are only created
if meal events are entered into the CarelLink iPro Logbook. The patient's Report Settings, if
different from the clinic Report Settings, determine what the periods are. The sensor traces for
each day are overlaid, so that you can look for trends at certain times related to meal or
overnight periods. This report lines up glucose sensor traces before and after each meal and is
especially useful if patients eat meals at varying times each day.

«  Daily Summary (two pages) - provides a summary of each full or partial 24-hour period of the
study, including both the sensor trace and events such as meals, medication, and exercise.

Optimal accuracy

Carelink iPro automatically performs certain checks for optimal accuracy of the data in a study.
These checks are designed to help you become aware of any data that may be less than optimal
for making therapy decisions.

The system evaluates the accuracy of the data on a calendar day basis, from midnight to midnight
for each day that sensor glucose values are recorded. There are three measurements to determine
the accuracy of the data: number of valid calibrations, mean absolute difference percentage (MAD

%), and correlation.

Days that do not meet one of the thresholds are designated as Use Clinical Judgment. This
designation appears in two places: on the Daily Overlay Report, and on the Daily Summary Report
for the individual day graph. On the Daily Overlay Report, those days that do not satisfy the criteria
are marked with an X in the Designation row.

If the Designation area is blank for a certain day on the Daily Overlay Report, then the data for that
day passes all optimal accuracy criteria.
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MAD%: the threshold for MAD% will vary depending on the range of BG meter values for the
calendar day. If the calendar day does not meet this threshold, it will be designated with an X
(Use Clinical Judgment).

If the BG meter reading range is greater than or equal to 100 mg/dL (or 5.6 mmol/L), then an
MAD% of 28.0 or less is considered optimal.

If the BG meter reading range is less than 100 mg/dL (or 5.6 mmol/L), then an MAD% of 18.0

or less is considered optimal.

# Valid Calibrations: 3 or more is considered optimal. If there are less than 3 valid calibrations
in a calendar day, then that day does not meet this threshold and will be designated with an
X (Use Clinical Judgment). This commonly occurs on a partial day of sensor wear, such as the
last day of the study.

The system evaluates the accuracy of the sensor glucose values in comparison with the BG
meter readings used for the calibration. Each BG meter reading used for calibration is paired
with the corresponding sensor glucose value generated by the calibration algorithm at the same

point in time.

Not all BG meter readings used for calibration are considered valid for purposes of optimal
accuracy evaluation. If no other BG meter reading (used for calibration) exists within 12 hours
before or after a calibration, then the BG meter reading is not considered valid for purposes of

optimal accuracy determination.

Only BG meter readings between 40 and 400 mg/dL (2.2 and 22.2 mmol/L) will be used for
calibration.

Correlation: 0.79 or greater is considered optimal. If the Correlation is less than 0.79, then that
calendar day does not meet this threshold and will be designated with an X (Use Clinical

Judgment).

When the BG meter reading range is less than 100 mg/dL (or 5.6 mmol/L) or the number of
valid calibrations is less than 3, then the Correlation is reported as N/A and is not evaluated,

for purposes of optimal accuracy.

If the correlation is high (close to 1.0), but the MAD% is high, this can be due to a single outlying
BG meter reading. This would cause a Use Clinical Judgment designation.

There are also two other designations that can appear on the Daily Overlay Report: S: No Sensor
Data and C: No Calibration BG's.

S: No Sensor Data: This designation occurs on a calendar day in which there is no sensor
data. Therefore, there are no sensor values on the reports for that day. The Daily Summary graph
for that day shows only BG meter readings plotted, if there are any, and no sensor data.

C: No Calibration BG's: This designation occurs on a calendar day in which there are sensor
values available, but there are no valid BG meter readings with which to calibrate the sensor
values. Sensor data that cannot be calibrated will be missing from the reports for that day.
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Area under the curve (AUCQ)

Area under the curve (AUC) information appears in the Excursion Summary on the Daily Overlay
Report. AUC provides more insight into how much time the patient's glucose was high or low, as
well as the severity of excursions outside of the target range. A high AUC indicates more excursions
or more severe excursions. The closer that AUC is to zero, the more that the patient's glucose stayed
within the target range.

AUC calculations are reported in mg/dL per day (or mmol/L per day). The Daily Overlay Report
provides two AUC amounts for each day: AUC Above Limit and AUC Below Limit.

«  AUC Above Limit: this statistic provides a relative indication of the overall extent and duration
of high glucose excursions over the entire day. The calculation is dependent on the patient
Glucose Target Range High setting. The High limit value is subtracted from each individual
sensor glucose value that exceeds the limit. The differences are summed and the sum total is
divided by the total number of sensor glucose values that exist for the day.

«  AUC Below Limit: this statistic provides a relative indication of the overall extent and duration
of low glucose excursions over the entire day. The calculation is dependent on the patient
Glucose Target Range Low setting. Each individual sensor glucose value that exceeds the limit
is subtracted from the Low limit value. The differences are summed and the sum total is divided
by the total number of sensor glucose values that exist for the day.

Patient Report Settings

When you first add a patient into CareLink iPro, the patient's Report Settings are set based on the
current Clinic Report Settings that are defined on the Clinic Settings tab. The Clinic Report Settings
are like a template for creating the Report Settings for each new patient. After a patient record has
been created, you can change the Report Settings for that patient's reports.

For example, the patient’s meal periods may not match the default meal periods, which were defined
for your clinic in the Clinic Report Settings. Or, the target glucose range for the patient may be
different from the default range set in the Clinic Report Settings.

In these cases, you can modify a patient’s report settings manually.

« If you change the Patient Report Settings before generating reports, future reports will be
generated based on the changes you made.

«  If you change the Report Settings after generating reports, you must choose whether you want
to apply the new settings to the most recent reports. You can also apply the new settings to
older studies. Existing study reports will not be updated automatically based on the new
settings.

After viewing the first reports you generate for a patient, you may decide to modify the Patient
Report Settings, and then generate the reports again based on the new settings.
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Modifying Patient Report Settings

1 Click the Edit link in the Patient Report Settings section of the patient record screen.
The patient’s General Report Settings and Overlay by Meal Report Settings are displayed.

2 Change the settings as needed. For more information about the General Report Settings and
Overlay by Meal Report Settings, see General Report Settings on page 19 or Overlay by Meal Report
Settings on page 19.

3 C(lick Save. A small window appears, asking if you want to apply these report settings to the
most recent set of reports.
- To apply the settings to the most recent reports, click Yes. The report settings screen
closes, and the patient record screen appears, where you can view and print the updated
reports.

The new Report Settings have been applied to the most recent study. You can then click
any of the reports for the most recent study to view and print one of them, or click Print
All to print all of the reports.

- To save the Report Settings for the patient but not apply them to any studies yet, click No.

If you want to apply the new Report Settings for the patient to one or more studies, find
the study on the patient record screen and select Regenerate reports from the Other
Options drop-down list. The reports are re-generated using the new Reports Settings.

Restoring the default report settings

If you want to set a patient’s report settings to the current default settings for your clinic, you can
do this in the Patient Report Settings. You will then have the option to choose which of the patient's
studies you want to show the changes to the report settings.

1 Click the Edit link in the Patient Report Settings section of the patient record screen.
The patient’s General Report Settings and Overlay by Meal Report Settings are displayed.
2 Click the Restore defaults button on the patient’s report settings screen.

3 Click Save. A small window appears, asking if you want to apply these report settings to the
most recent set of reports.
- To apply the settings to the most recent reports, click Yes. The report settings screen
closes, and the patient record screen appears, where you can view and print the updated
reports.

The new Report Settings have been applied to the most recent study. You can then click
any of the reports for the most recent study to view and print one of them, or click Print
All to print all of the reports.

- To save the Report Settings for the patient but not apply them to any studies yet, click No.
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If you want to apply the new Report Settings for the patient to one or more studies, find
the study on the patient record screen and select Regenerate reports from the Other
Options drop-down list. The reports are re-generated using the new Reports Settings.

Generating a Data Table report

If necessary, you can generate a Data Table report (about 15 pages or more). This report lets you
view detailed sensor glucose readings, and events that are recorded in the Logbook. The Data Table
is used by Medtronic employees for troubleshooting purposes. Most of the time, you do not need
it in order to understand a study.

1 In the patient record screen, select Generate Data Table from the Other Options drop-down
list.

After a few moments, a new Data Table PDF link appears.
2 C(lick the link to view the report. The report opens in a new browser window or tab.

Or, click Print to print the report without viewing it first.

Exporting data to CSV file

If necessary, you can export report data as a character-separated values (CSV) file for further
analysis. A CSV export is raw data, typically for clinical study use. Additional information in the data
is used by Medtronic employees for troubleshooting purposes. Most of the time, you do not need

it in order to understand a study.
1 In the patient record screen, select Export data from the Other Options drop-down list.
After a few moments, a dialog box opens, allowing you to save the file on the computer.

2 Save the file on your computer or network. You can now open the file directly, for example, in

Microsoft” Excel® or Access’.
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CarelLink iPro ongoing use

administrator
tasks

Key Notes:

«  Click the Resources hyperlink in CareLink iPro to print the newest log sheets and other forms.

«  Only administrative users can add, modify, and delete CareLink iPro user accounts. Always make

sure more than one person has administrative privileges.

«  Any Carelink iPro user can edit patient information when needed.
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User tasks

Printing more log sheets and other forms

Your original iPro2 shipment may have included samples of Patient Log Sheets, Clinic Equipment
Logs, and other documents that your clinic wants to use regularly. You can easily download and
print more of these documents.

1 Click the Resources link at the bottom of the CareLink iPro screen.
2 Find the document that you want and open it.

3 Select the print option in your browser.

Changing your password or other user information

As a Carelink iPro user, you can change your own password, email address, and other information

in your user account.

1 Sign in to CareLink iPro.
2 (lick the My Info link. The My Info screen is displayed.

3 If you want to change your password, select the Change Password check box. The password
fields become active. Type your new password in the Password field, and re-type it in the Re-

enter Password field.
4 Modify the other information as needed.
5 Click the Save button. If you changed your password, use your new password the next time

you sign in.

Editing patient information

You may occasionally need to update patient information, such as the patient's name, therapy
type, or physician. Any user can update any patient's information for your clinic.

1 On the patient record screen, click the Edit patient information link.

2 Update the patient's information as needed.

3 Click the Save button. The changes have been saved, and any information that shows up on
reports will be updated the next time you generate reports for the patient.
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Moving a patient study

If you accidentally upload an iPro2 study to the wrong patient record in CareLink iPro, you can
move the study to the correct patient record.

Use the Clinic Equipment Log if needed, to help you find the dates when each patient wore the
iPro2.

1 Confirm that the patient whose study was uploaded incorrectly has been added to CarelLink
iPro. If the patient record does not exist yet, you need to create it now. For details, see Opening
the patient record on page 43.

2 After you have confirmed that the correct patient exists in the system, open the patient record
that contains the study that needs to be moved.

3 Find the study that you want to move in the list of studies for that patient.

4 If you see a message that the study is incomplete, enter the patient's BG meter readings by
uploading the meter or using the Logbook.

5 In the Other Options drop-down list, select Move this study.

6 Follow the on-screen instructions to find the correct patient and move the study to that patient's
record.

When the move is complete, the reports will be regenerated for the correct patient.
Modifying clinic information

You may periodically need to edit the identifying information of the clinic that was entered when
the clinic account was first created. Some of this information appears on patient reports, so it is
important to keep the clinic information accurate.

1 In the Clinic Settings tab, click Clinic Information. The clinic information is displayed.

If you do not see the Clinic Settings tab, click the Home tab. You should now see the Clinic
Settings tab.

2 Update the information as needed and click the Save button.

3 When you are finished, click Close clinic settings to return to the Patient List.

iPro2 CGM User Guide  CareLink iPro ongoing use 59

P150029 PMA Final Labeling Amendment P150029
Medtronic Confidential 1-81



Administrator tasks

If you are administrative user, you will need to create, modify, or delete CareLink iPro user accounts
for your clinic as new employees join the clinic and others leave.

Creating user accounts

1 Get a list of names and email addresses for staff members who need CareLink iPro user accounts.
2 In the Clinic Settings tab, click Users. The existing user accounts are displayed.
If you are not logged in as an Admin user, you will not see the Users tab.
3 Click the Create new user button. The Create New User screen appears.
4 Enter the required information about the user.

5 If you want this user to have permission to manage user accounts, select the Administrative
Privileges check box.

Important: Always make sure that at least two people have administrative privileges. If an
Admin user leaves the clinic, add a new one.

6 Click Save.

NOTE: Usernames must be unique among all CarelLink iPro clinics in the system, not just
your clinic. If the username you entered is not available, the system informs you that you
must try a different username.

7 Make a note of the username and password so that you can provide them to the user. He or
she will need this information to sign in and select a new password.

Repeat this procedure for each user account that you need to create.

Modifying user accounts

If you have administrative privileges, you can modify a user account. For example, you may need
to change a user password, or grant or remove administrative privileges.

1 In the Clinic Settings tab, click Users. The existing user accounts are displayed.

2 Select the user account and click the Open user button. The user account information appears.
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3 If you want to edit the user account information, such as the password, enter the information
and click the Save button.

Deleting user accounts

If you have administrative privileges, you can delete a user account. You need to delete user
accounts for users who no longer should have access to CareLink iPro for your clinic, so that they
can no longer access patient records.

1 In the Clinic Settings tab, click Users. The existing user accounts are displayed.

2 Select the user account and click the Open user button. The user account information appears.
3 If you want to delete the user account, click the Delete User button.
4 In the confirmation screen, click Yes.
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System maintenance

cleaning and
disinfecting

storing equipment
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Key Notes:
Always connect the cleaning plug to the iPro2 before cleaning.

«  When not in use, leave the iPro2 connected to the Dock, so it will be ready for use with the
next patient.

« If an iPro2 is unused for several weeks, you must store it on a powered Dock. Otherwise, the
iPro2 battery could become damaged.

«  Keep extra Patient Log Sheets and other iPro2 supplies in an organized cabinet.
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Cleaning the iPro2

Always clean and disinfect the iPro2 after removing it from a patient. Make sure to connect the
cleaning plug to the iPro2 before cleaning and disinfecting. For complete instructions, see Cleaning
and disinfecting the iPro2 on page 38.

Cleaning the Dock

The Dock cannot be disinfected. This procedure is for general cleaning as required, based on physical

appearance.

WARNING: Always clean and disinfect the iPro2 after removing it from the patient and before
attaching it to the Dock. If the Dock's connector comes in contact with blood, the Dock must be
discarded because the Dock's connector cannot be disinfected. Dispose of the Dock according
to the local regulations for electronic devices.

CAUTION: The Dock is not watertight. Do not immerse in water or any other cleaning agent. Do
not allow liquid to come in contact with the Dock's connector, USB port, or reset button.
Repeated exposure to liquid could damage the connector and affect the performance of the
device. If liquid comes in contact with the connector, allow the Dock to air dry before

proceeding with the cleaning instructions.

1 Disconnect the Dock USB cable from the computer or wall-powered adapter.
2 Disconnect the Dock from the USB cable.

3 Use a damp cloth with mild cleaning solution, such as a dishwashing detergent, to clean any
dirt or foreign material from the outside of the Dock. Never use organic solvents such as paint

thinner or acetone to clean the Dock.
4 Place the Dock on a clean, dry cloth and allow it to air dry completely.

5 When the Dock is completely dry, you can reconnect it to the computer or wall-powered adapter
with the USB cable.

Components that cannot be cleaned

You cannot clean the following components of the iPro2 system:

«  Cleaning plugs (discard each cleaning plug after 30 uses)
Wall-powered adapter

«  Dock USB cable
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Charging the iPro2 between studies

Charge the iPro2 in the Dock. The Dock can be connected to the computer or to the wall-powered
adapter, which lets you use a regular power outlet for charging. While the iPro2 is charging, the
green charging light on the Dock is flashing, as shown:

VL7
7N

Between patient studies, the iPro2 should take less than 30 minutes to reach a full charge. When
the iPro2 is fully charged, the green charging light on the Dock remains on:

O

CAUTION: If the green charging light continues to flash and never turns solid, this indicates

that the iPro2 contains patient data that you have not uploaded. You cannot use the iPro2 for
another study until you upload the data. If you need to clear the data without uploading it,
you can perform a reset. For details, see Resetting the iPro2 on page 76.

Always leave the iPro2 connected to a powered Dock when not in use. This maintains the life of
the iPro2 battery and keeps the iPro2 ready for the next patient study.

If your clinic has only one iPro2, you can leave the Dock connected to the computer and connect
the iPro2 to the Dock when not in use. The computer supplies enough power to charge the

iPro2, as long as the computer is on and the white Dock power light is on @

If you have multiple iPro2s, you can use the wall-powered adapters to keep them charged at power
outlets, and leave one Dock connected to the computer at all times so that it is ready to upload
data.
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Tip: To extend the life of your Docks, mark your calendar to periodically exchange the Dock that

you have connected to the computer with a Dock that is connected to an electrical socket. The

Dock connected to the computer gets the most use, and the connector pins can wear out over time.

Storage and organization tips

When not in use, store the iPro2 on the Dock and keep the Dock plugged in, so that the iPro2

remains charged. Otherwise, the iPro2 battery could become damaged.

You can organize your other iPro2 supplies in a small drawer organizer, such as the one shown

here. These are some of the items that you will want to keep on hand and ready for the next patient:

. Serter

«  Glucose sensors

«  Occlusive adhesive dressings

«  Alcohol swabs

«  Liquid dishwashing detergent

«  Adhesive remover

« Gloves

+  Documents and forms, including:

Patient Log Sheets

Patient Consent Forms
Patient Instructions Sheets
Clinic Equipment Log Sheets
Clinic Checklists
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- A printed copy of this User Guide
«  Cleaning plugs
«  Gauze pads or cloth
+  70% isopropyl alcohol
«  ENZOL® Enzymatic Detergent
«  Bleach (6% sodium hypochlorite)
«  Soft-bristled brush
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Troubleshooting

This appendix contains troubleshooting information for the iPro2 CGM System. Please refer to these

instructions before contacting the 24 Hour HelpLine.

Troubleshooting reference

Did you take the iPro2 directly from a powered Dock, and did
the Dock display a solid green charging light?

| connected the iPro2
to the sensor, and
the iPro2 did not
flash after 20
seconds.

Either the sensor is
not adequately
hydrated, the iPro2 is
not connected
properly, or the iPro2
is not ready to begin
a study.

If yes, then the iPro2 may not be connected properly, or the
sensor may not be fully hydrated. Disconnect and reconnect
the iPro2. If this does not work, wait another five minutes
and then connect the iPro2 to the sensor. If the iPro2 still
does not flash, wait another five minutes and try again. In
some cases, it can take up to two hours for the sensor to
become hydrated.

If the iPro2 still does not flash after two hours, you can
remove the sensor and insert a new sensor in a different site
on the body.

If no, or if you are not sure, the iPro2 may not be fully
charged, or may still contain data from a previous study. In
these cases, the green light will not flash when connected
to the sensor.

Disconnect the iPro2 from the sensor. Clean and disinfect it
(see Cleaning and disinfecting the iPro2 on page 38), and then
connect it to the Dock. If the green charging light on the
Dock turns solid after two minutes, the iPro2 is ready to start
a study on a new patient. If not, the iPro2 needs to be
charged or still contains patient data from the previous
study.

If these steps do not work, use the Dock to reset the iPro2. For
instructions, see Resetting the iPro2 on page 76.
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The iPro2 has been
connected to the Dock
with adequate power for
two to three hours, but the
green charging light keeps
flashing.

The iPro2 most likely
contains data that has not
been uploaded.

Check the Clinic Equipment Log or Patient Log
Sheets to find out which patient's data was last
collected. Open CareLink iPro and check to see
if a study was uploaded for the dates on the log
sheet. If there is no study, upload the iPro2 into
that patient's record in CarelLink iPro. CareLink
iPro clears the data off of the iPro2 as part of
the upload process. You must then wait for the
green charging light on the Dock to turn solid
before the iPro2 is ready to use for the next
patient.

If you are unable to identify which patient's data
is still on the iPro2, or if you are unable to
upload the iPro2 successfully, you may need to
reset the iPro2. For instructions, see Resetting
the iPro2 on page 76.

The reports only show a
partial study. Data ends
before study was supposed
to end.

A common cause of a
partial study is sensor
pullout.

If the sensor was not
pulled out, the iPro2
battery may not have had
sufficient power to
complete the study.
CarelLink iPro checks the
iPro2 battery and displays
a message during the
upload process to warn
you that there might be a
problem:

The iPro2 Recorder
battery is not charging
properly. Please refer to
the User Guide for
assistance.

Also, the Dock displays a
solid red warning light
when there may be a
problem with the iPro2
battery.

If the sensor pulled out, make sure that the
sensor is fully inserted and properly taped to
the skin for future studies.

If you did not see an error message in CarelLink
iPro during the uploading process, it could be
that there are not enough BG meter readings
for calibration after a certain point in the study.

Make sure that you have entered all of the
patient's BG meter readings into CareLink iPro.
Carelink iPro needs good BG meter readings in
order to calibrate sensor data. Less than three
BG meter readings per day, or more than 12
hours between BG meter readings, can result in
data gaps.

If you saw a CareLink iPro error message, see
the troubleshooting steps for that error
message in this section.
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There are gaps in the
sensor data in the reports.

A common cause of data
gaps is partial sensor
pullout.

There can also be
calibration problems due
to an insufficient number
of BG meter readings,
readings that are more
than 12 hours apart, or
readings that are out of
the expected range.

Make sure that you have entered all of the patient's
BG meter readings into CareLink iPro. CareLink iPro
needs good BG meter readings in order to calibrate
and report sensor data. Less than three per day can
result in data gaps.

Also check the sensor trace on reports to see if
there are BG meter readings not used for
calibration. Bad BG meter readings are identified as
calibration errors. These BG meter readings are not
used for calibration and cause the sensor plot to
stop. The sensor plot starts again at a good BG
meter reading. You can eliminate some data gaps
by excluding bad BG meter readings using the
Exclude feature in the Logbook.

Some sensor pullouts can be avoided by applying
an adhesive dressing over the iPro2 and sensor.

Always advise patients to test their blood glucose
at least four times a day.

| uploaded the wrong
meter for a patient. Can |
fix this?

In the Logbook screen, check the Exclude check
box to exclude all of the BG meter readings that
came from the wrong meter. The readings from the
wrong meter will still be in the Logbook, but they
will not affect sensor calibration or reports. If you
find the right meter or log sheets for the patient,
you can manually enter the BG meter readings from
the right meter.

Also, you can still upload the meter to the correct
patient study.

| uploaded the wrong iPro2
for a patient. Can | fix this?

Yes, you can move the entire study from the
incorrect patient record to the correct patient
record. For details, see Moving a patient study on
page 59.

| connected the iPro2 to
the Dock and no lights
came on.

The Dock may not be
connected to the
computer, or it may not
have sufficient power. The
white Dock power light

@ must be on before

connecting the iPro2.

Try connecting the Dock to a different USB port on
the computer. Wait for all three lights to flash,
followed by a solid white light. If the Dock is
connected to the computer but none of the lights
turn on, there may be other USB devices connected
that are using up power. Disconnect other devices.
Do not connect more than one Dock at a time to a
computer. You can also try connecting the Dock to
another computer.

If the white Dock power light is on, but the three
lights do not flash when you connect the iPro2,
check the iPro2 connector pins for damage or
moisture. For assistance in locating the connector
pins, see Checking the iPro2 connector pins on
page 74.

If the pins are damaged or corroded, the iPro2
cannot communicate with the Dock or CareLink
iPro. Contact the 24 Hour HelpLine. It may be time
to replace the iPro2.
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| connected the iPro2 to
the Dock and all three
lights are flashing on and
off repeatedly.

This could mean that the
iPro2 is not properly
connected to the Dock.

Disconnect and reconnect the iPro2 to the Dock.

The iPro2 is connected to
the Dock and the red
warning light is on.

©

This could mean that the
iPro2 is not properly
connected to the Dock or
needs to be reset. It also
could mean that there is
damage to the iPro2
battery, circuitry, or
connector pins. The iPro2
may need to be replaced.

Disconnect the iPro2 and check the connector pins
for damage, corrosion, or moisture. For assistance in
locating the connector pins, see Checking the iPro2
connector pins on page 74. After you confirm that
the pins are not damaged or corroded, reconnect
the iPro2 to the Dock. If another Dock is available,
try connecting the iPro2 to the other Dock.

If there is sensor data on the iPro2, upload the
sensor data using CareLink iPro.

If the red warning light turns on again, perform a
reset as described in Resetting the iPro2 on

page 76. Allow the iPro2 to charge for 20 minutes.
Please note that by performing a reset, all iPro2
sensor data will be erased.

If the red warning light continues to turn on, or if
the iPro2 pins are damaged or corroded, contact
the 24 Hour HelpLine. It may be time to replace the
iPro2.
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CareLink iPro messages

CareLink iPro displayed this
message during the upload
process:

iPro2 Docking Station not
found. Please connect the
iPro2 Docking Station to
the computer.

A Dock is not connected to
the computer, it is not
securely connected, or it
has insufficient power from
the computer to operate.

If the white Dock power light is on, then the USB
cable may not be securely connected. Make sure
that the cable is plugged in all the way to the Dock
and to the computer.

If the white Dock power light is not on, try
connecting the Dock to a different USB port on the
computer. Wait for all three lights to flash, followed
by a solid white light. If the Dock is connected to
the computer but none of the lights turn on, there
may be other USB devices connected that are using
up power. Disconnect other devices. Do not
connect more than one Dock at a time to a
computer.

If you are using a USB hub, it may not be receiving
enough power for the Dock to operate. Try using a
powered hub, which has its own electrical plug that
connects to an electrical socket.

CareLink iPro displayed this
message during the upload
process:

Device not found in iPro2
Docking Station. Please
connect iPro2 Recorder.

The iPro2 is not in the
Dock, or it is not properly
connected. This message
may also appear if the
iPro2 connector pins are
damaged or corroded, or if
there is moisture in the
connector opening.

If your iPro2 is connected, try disconnecting and
reconnecting the iPro2 to the Dock.

If the white Dock power light is on, but the three
lights do not flash when you connect the iPro2, the
iPro2 may be damaged. Check the iPro2 connector
pins for moisture, damage, or corrosion. For
assistance in locating the connector pins, see
Checking the iPro2 connector pins on page 74.

If the iPro2 pins are damaged or corroded, the
iPro2 cannot communicate with the Dock or
CareLink iPro. Contact the 24 Hour HelpLine. It may
be time to replace the iPro2.

CareLink iPro displayed this
message during the upload
process:

iPro2 Recorder is not
responding. Please
confirm the connected
device is an iPro2
Recorder and try again.

The red warning light on
the Dock is on.

O

The Dock only works with iPro2s. You may be
trying to upload the wrong device. The iPro2 has

an "i" on the front of it.

If you are trying to upload an original iPro digital
recorder, you must use a ComLink and upload it
into Solutions™ Software for CGMS™ iPro™
Continuous Glucose Recorder. If the device is a
MiniLink, it cannot be used for an iPro2 CGM study.

If you are sure that the device is an iPro2, it may
not be properly connected. Try disconnecting the
iPro2 from the Dock and then reconnecting it.

If the problem continues, check the iPro2 connector
pins for moisture, damage, or corrosion. For
assistance in locating the connector pins, see
Checking the iPro2 connector pins on page 74. If the
pins are damaged or corroded, contact the 24 Hour
HelpLine. It may be time to replace the iPro2.

If the iPro2 connector pins are not damaged, the
iPro2 may need to be reset. For instructions, see
Resetting the iPro2 on page 76.
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CareLink iPro displayed this
message during the upload
process:

The iPro2 Recorder
battery is not charging
properly. Please refer to
the User Guide for
assistance.

The red warning light on
the Dock is on.

O

The iPro2 battery may be
reaching the end of its life.
However, this message
may also appear if the
iPro2 connector pins are
damaged or corroded, or if
there is moisture in the
connector opening.

Disconnect the iPro2 and reconnect it to the Dock.
Allow the iPro2 to charge for 20 minutes. The green
charging light may flash at first, but if the red
warning light turns on again, check the iPro2
connector pins for moisture, damage, or corrosion.
For assistance in locating the connector pins, see
Checking the iPro2 connector pins on page 74.

If the red warning light continues to turn on,
perform a reset as described in Resetting the iPro2
on page 76. Please note that if you saw this error
message in CareLink iPro, the recent patient data
was successfully uploaded, but you may wish to
confirm this before performing the reset. If the
Dock displays a solid green charging light, the reset
was successful.

If the iPro2 connector pins are damaged or
corroded, or the Dock still displays a red warning
light for the iPro2 after the reset, contact the 24
Hour HelpLine. It may be time to replace the iPro2.

CareLink iPro displayed this
message during the upload
process:

Possible damage to iPro2
Recorder circuitry. Please
refer to the User Guide
for assistance.

The red warning light on
the Dock is on.

O

There may be moisture,
damage, or corrosion in
the iPro2 connector
opening, or the iPro2 may
need to be reset.

Disconnect the iPro2 and reconnect it to the Dock.
Charge the iPro2 for 20 minutes. If the Dock
displays a solid green charging light, the
reconnection was successful.

If the green charging light flashes at first, and then
the red warning light turns on, check the iPro2
connector pins. For assistance in locating the
connector pins, see Checking the iPro2 connector
pins on page 74.

If you do not find any problems inside of the
connector opening, and the green charging light
never remains on without flashing when you
connect the iPro2 to the Dock, perform a reset as
described in Resetting the iPro2 on page 76, and
charge the iPro2 for one hour. Please note that if
you saw this error message in CarelLink iPro, the
recent patient data was successfully uploaded, but
you may wish to confirm this before performing the
reset. If the Dock displays a solid green charging
light, the reset was successful.

If the red warning light continues to turn on,
contact the 24 Hour HelpLine. It may be time to
replace the iPro2.
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CarelLink iPro displayed this
message during the upload
process:

Transfer failed: An
unrecoverable data error
has been detected in the
device's data. Please refer
to the User Guide for
assistance.

The data on the iPro2
cannot be recovered.
CareLink iPro cannot
complete the data upload.
There may be a problem
with the device.

Contact the 24 Hour HelpLine for assistance. You
may be instructed to reset the iPro2. Please note
that resetting the iPro2 erases all data from the
iPro2.

CarelLink iPro displayed this
message during the meter
upload process:

An unrecoverable data
error has been detected
in the device's data.
Please refer to the User
Guide for assistance.

This message is different
from the message above. It
appears when CareLink
iPro cannot complete the
meter data upload.

Enter the BG meter readings manually using the
Logbook screen in CareLink iPro.
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Checking the iPro2 connector pins

If the troubleshooting reference advises you to check the connector pins of the iPro2, use the
following image to assist you. This image is an example of how the connector pins should look.

connector opening

connector pins

housing

Look inside the iPro2’s connector opening to make sure that the connector pins are not damaged
or corroded. If the connector pins are damaged or corroded, the iPro2 cannot communicate with
the Dock or CareLink iPro. Contact the 24 Hour HelpLine. It may be time to replace the iPro2.

Also look for moisture inside the connector opening. If you see any moisture, allow the iPro2 to dry
for at least one hour. Moisture inside the connector opening could cause the iPro2 to not work

properly, and could cause corrosion and damage over time.

To help prevent damage to the pins:

«  Make sure to carefully connect the cleaning plug or sensor to the iPro2.

« Do not twist or bend the cleaning plug or sensor when connecting to the iPro2.

For instructions on how to properly clean the iPro2 using the cleaning plug, see Cleaning and
disinfecting the iPro2 on page 38. For instructions on how to properly connect the iPro2 to a

sensor, see Connecting the iPro2 to the sensor on page 33.
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Dock lights quick reference

The Dock is not plugged into an electrical outlet or
All of the lights are off. computer USB port. If it is plugged in, it may not
be receiving enough power.

The Dock is connected to power. If connected to an
electrical outlet, it is ready to charge an iPro2. If
connected to a computer USB port, it is ready to
charge an iPro2 or upload data from an iPro2. The
iPro2 is not connected to the Dock.

The white Dock power
light is on.

All of the Dock lights flash once when you first
All three lights flash once. connect the Dock to a sufficient power source, or
when you connect the iPro2 to the Dock.

The iPro2 is charging or the iPro2 contains data
that must be uploaded using CarelLink iPro. After
you upload data, if the green charging light
continues to flash, the iPro2 is still charging and is
not ready to begin a new patient study.

The white Dock power
light is on and the green
charging light is flashing
continuously.

The white Dock power All previous data has been cleared from the iPro2.
light and green charging The iPro2 is fully charged and ready for the next
light are on. patient study.

The white Dock power light will flash five times
after you press the reset button. The green
charging light will continue to flash as the iPro2
charges. When the iPro2 is fully charged, the green
charging light will stop flashing and remain on.

The white Dock power
light flashed five times and
the green charging light is
flashing continuously.

The white Dock power
light and the red warning
light are on.

There may be a problem with the iPro2. See
Troubleshooting reference on page 67 for details.
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Resetting the iPro2

CAUTION: This procedure erases all patient data from the iPro2. Do not perform these steps
unless you have already uploaded the last patient study, or you are prepared to erase any data
that may be on the iPro2.

1 Connect the Dock to power and make sure that the white Dock power light is on. @

2 Place the iPro2 into the Dock.

3 Find the small hole on the back of the Dock, next to the USB cable.

4 Insert the end of a small paper clip into the hole about 1/8 inch (0.30 cm). Push the reset button

once and release. The white Dock power light will flash @ After a few seconds, the green

light on the iPro2 will flash. @

Important: Do not apply excessive pressure, or the reset button may be damaged.

iPro2 CGM User Guide  Troubleshooting 76

P150029 PMA Final Labeling Amendment P150029
Medtronic Confidential 1-98



5 Wait for the Dock to show a solid green charging light . This indicates that the data has

been cleared, and the iPro2 is fully charged and ready for the next patient study.
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Enlite Sensor Performance for the iPro2

CGM performance

The iPro2 Continuous Glucose Monitoring (CGM) is intended to continuously record interstitial
glucose levels in persons with diabetes mellitus. This information is intended to supplement, not
replace, blood glucose information obtained using standard home glucose monitoring devices. The
information collected by the iPro2 digital recorder may be uploaded to a computer (with Internet
access) and reviewed by healthcare professionals. The information may allow identification of
patterns of glucose-level excursions above and below a desired range, facilitating adjustments, which
may minimize these excursions.

Clinical study description

The performance of the Enlite sensor was evaluated in a clinical study’. This inpatient (in-clinic) and
outpatient (at home) study included subjects 18 to 75 years in age. The study design was a multi-
center, prospective single-sample correlational design without controls. All subjects were assigned
to treatment. Each subject was instructed to wear two Enlite sensors connected to two MinilLink
transmitters and two Revel™ 2.0 pumps (which use the same CGM technology as the MiniMed 530G
insulin pump). Bayer's CONTOUR® NEXT LINK Wireless Meter was used as the study meter, and was
used for all calibrations in this study. This system was tested with Bayer's CONTOUR® NEXT LINK
Wireless Meter, but has not been tested with other meters. Therefore, the performance of this system
with other blood glucose meters may differ from the performance with the Bayer's CONTOUR® NEXT
LINK Wireless Meter described below.

On days 1, 3, and 6, frequent sample testing (FST) was performed. Reference blood (plasma) glucose
values were obtained with a Yellow Springs Instrument (YSI®) Glucose Analyzer every 5-15 minutes
and compared with sensor glucose values. During the FSTs, the subjects were instructed to calibrate
one sensor three to four times spread throughout the day, and calibrate the other sensor, once
every 12 hours. During home use (outside the clinic), subjects were instructed to calibrate both
sensors three to four times spread throughout the day.
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A total of 111 subjects previously diagnosed with type 1 or 2 diabetes were enrolled in the study,
20 subjects failed the screening, 61 subjects with abdominal insertions completed the study, and
one subject enrolled after the study was completed. During each FST, subjects with an established
insulin sensitivity ratio and insulin carbohydrate ratio underwent a hypoglycemic challenge and a
hyperglycemic challenge. Subjects were instructed to continue with their current diabetes regimen
(including glucose monitoring with their own meter when desired) independent of their use of the
study devices. The Revel 2.0 pumps were not used to infuse insulin or manage diabetes during this
study. The meter was used for confirmation of alarms, treatment decisions and sensor calibrations.
The sensor signal is retrospectively calibrated with CareLink iPro and evaluated against YSI reference
glucose values.

1 Medtronic Inc., A Performance Evaluation of the Enlite Glucose Sensor to Support a Full 144 hours (6 Days) of Use, CER247/

Z25/C, May 2012

Results

Mean and median absolute relative difference, by number of daily calibrations

The overall mean absolute relative difference (ARD) between the Enlite sensor (CGM readings) and
the reference YSI values was 15.6% and the median ARD was 11.1%, from inpatient frequent sample

testing (FST) during hypoglycemic and hyperglycemic challenges.

Table 1. CGM difference to YSI within YSI glucose ranges; Calibrating three to four
times daily, Abdomen insertion site

Overall 7272 7.40 5.19 15.57 11.11
<40* 3 23.52 10.65 23.52 10.65
40-60* 604 9.55 8.82 13.97 11.05
61-80* 1369 10.07 9.85 15.94 12.75
81-180 3200 7.04 6.12 13.57 10.08
181-300 1613 0.77 1.12 10.79 7.90
301-350 313 0.58 0.31 9.30 7.97
351-400 143 -5.81 -3.24 9.57 6.41
>400 27 -16.04 -14.03 16.04 14.03

*For YSI reference range < 80 mg/dL, the differences in mg/dL are included instead of percent difference

(%).
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NOTE: CGM Readings are within 40-400 mg/dL.

Table 2. CGM difference to YSI within YSI glucose ranges; Calibrating every 12 hours,
Abdomen insertion site.

>400 51 -12.71 -11.60 12.71 11.60

*For YSI reference range < 80 mg/dL, the differences in mg/dL are included instead of percent difference
(%).

NOTE: CGM Readings are within 40-400 mg/dL.

Table 3. CGM difference to YSI within CGM glucose ranges; Calibrating three to four
times a day, Abdomen insertion site.

351-400 196 -7.69 -8.25 10.61 9.15

*For CGM range < 80 mg/dL, the differences in mg/dL are included instead of percent difference (%).
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Table 4. CGM difference to YSI within CGM glucose ranges; Calibrating every 12
hours, Abdomen insertion site.

351-400 241 -4.37 -3.61 8.94 6.62

*For CGM range < 80 mg/dL, the differences in mg/dL are included instead of percent difference (%).

Percent agreement, by number of daily calibrations

The accuracy of the Enlite sensor (CGM) was also evaluated by calculating the percentage of CGM
readings within £15%, £20%, +30%, and +40% of the YSI values (or within £15, £20, £30, or +40
mg/dL in the low glucose range of 40-80 mg/dL). These results are shown for various YSI glucose
ranges when calibrating three to four times a day and also for calibrating every 12 hours. For
example, 90.6% of all Enlite sensors readings (from 40 to 400 mg/dL) were within 30% of the YSI

value when calibrating three to four times per day.

Table 5. Agreement (%) of CGM-YSI paired points within YSI Glucose Ranges,
Abdomen insertion site, calibrating three to four times a day.

7272 67.10% 78.60% 90.60% 96.40% 3.60%
>40-60* 64.60% 76.20% 88.60% 96.50% 3.50%

>80-180 3200 65.50% 77.20% 90.10% 95.70% 4.30%
>300-350 79.90% 90.10% 98.10% 99.40% 0.60%

>400 27 55.60% 81.50% 88.90% 92.60% 7.40%
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*For YSI reference range < 80 mg/dL, agreement was based on 15/20/30/40 mg/dL.

NOTE: CGM Readings are within 40-400 mg/dL.

Table 6. Agreement (%) of sensor-YSI paired points within YSI Glucose Ranges,
Abdomen insertion site, calibrating every 12 hours.

Overall 7729 70.50% 81.70% 92.80% 96.70% 3.30%
<40* 3 66.70% 100.00% 100.00% 100.00% 0.00%
>40-60* 546 58.10% 75.80% 90.80% 95.20% 4.80%
>60-80* 1394 63.60% 75.50% 90.50% 95.30% 4.70%
>80-180 3280 68.10% 80.50% 92.70% 96.90% 3.10%
>180-300 1922 79.70% 87.20% 94.20% 97.00% 3.00%
>300-350 360 81.90% 90.60% 96.90% 99.40% 0.60%
>350-400 173 87.30% 91.90% 96.00% 98.80% 1.20%
>400 51 66.70% 88.20% 94.10% 96.10% 3.90%

*For YSI reference range < 80 mg/dL, agreement was based on 15/20/30/40 mg/dL.

NOTE: CGM Readings are within 40-400 mg/dL.

Similarly, the accuracy of the Enlite (CGM) sensor was also evaluated by calculating the percentage
of Enlite sensor readings within £15%, £20%, £30%, and +40% (or within £15 , £20, +30, or +40
mg/dL in the low glucose range of 40-80 mg/dL) of the YSI values. These results are shown for

various CGM glucose ranges when calibrating three to four times a day and also for calibrating every

12 hours. For example, 91.7% of all Enlite sensors readings (from 40 to 400 mg/dL) were within 30%

of the YSI value when calibrating three to four times per day.

Table 7. Agreement (%) of sensor-YSI paired points within CGM glucose ranges,

Abdomen insertion site, calibrating three to four times a day.

Overall 7272 68.80% 79.80% 91.70% 97.00% 3.00%
>40-60* 510 77.30% 87.10% 94.90% 97.60% 2.40%
>60-80* 892 79.40% 89.60% 96.50% 97.90% 2.10%
>80-180 3642 59.30% 71.40% 87.20% 95.70% 4.30%
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Table 7. Agreement (%) of sensor-YSI paired points within CGM glucose ranges,
Abdomen insertion site, calibrating three to four times a day.

>180-300 1734 77.20% 87.00% 96.00% 98.40% 1.60%

>350-400 196 77.60% 88.30% 98.00% 100.00% 0.00%

*For CGM reference range < 80 mg/dL, agreement was based on 15/20/30/40 mg/dL.

Table 8. Agreement (%) of sensor-YSI paired points within CGM glucose ranges,
Abdomen insertion site, calibrating every 12 hours.

7729 71.00% 82.30% 92.70% 96.90% 3.10%
>60-80* 80.20% 91.80% 98.30% 99.40% 0.60%
>180-300 1904 79.80% 88.90% 95.70% 97.80% 2.20%

>350-400 241 79.30% 91.70% 97.50% 99.20% 0.80%

*For CGM reference range < 80 mg/dL, agreement was based on 15/20/30/40 mg/dL.

Table 9 and 10. The number and percentage of YSI values collected when CGM
readings displayed ‘Low’ (less than 40 mg/dL) and ‘High’ (greater than 400 mg/dL);
Calibrating three to four times a day, Abdomen insertion site.
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Tables 11 and 12. The number and percentage of YSI values collected when CGM
readings displayed ‘Low’ (less than 40 mg/dL) and ‘High’ (greater than 400 mg/dL);
Calibrating every 12 hours, Abdomen insertion site.

The following tables show the percentage of concurrent CGM readings with YSI reference values.
With ideal performance the CGM readings would match the YSI values, therefore the bold
percentages would ideally be 100 percent.

Table 13.The concurrence of YSI values and CGM readings using YSI glucose
ranges; Calibrating three to four times a day, Abdomen insertion site.

Ys

Glucose (’;‘f“r’g?reerd >60- | >80- | >120 | >160 | >200 | >250 | >300 | >350 | _,.

Ranges 80 120 | -160 | -200 | -250 | -300 | -350 | -400
CGM-YSI

(mg/dL)

445 | 386 16.7
% % %

>=40-60 604 0.0% 02% | 00% | 0.0% | 0.0% | 0.0% | 0.0% | 0.0%
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Table 13.The concurrence of YSI values and CGM readings using YSI glucose
ranges; Calibrating three to four times a day, Abdomen insertion site.

>80-120 | 1412 00% | 16% | 7.8% f/:'o 02/23.2 12% | 02% | 0.0% | 0.0% | 0.0% | 0.0%

5160-200 | 973 00% | 0.0% | 0.0% | 1.7% (1,/:'4 f:" 3/05'5 1.0% | 02% | 0.0% | 0.0%

>250-300 | 495 0.0% | 00% | 0.0% | 0.6% | 0.0% | 2.0% 232 539 168 3.4% | 0.0%
% % %

5350-400 | 143 0.0% | 0.0% | 0.0% | 00% | 0.0% | 21% | 3.5% | 7.0% 3:"6 f/;’"s 0.0%

Table 14.The concurrence of YSI values and CGM readings using YSI glucose
ranges; Calibrating every 12 hours, Abdomen insertion site.

YSI

Glucose (’;'f”g'?r:j <40 | >=40 | >60- | >80- | >120 | >160 | >200 | >250 | >300 | >350 | _, o

Ranges 60 | 80 120 | -160 | 200 | -250 | -300 | -350 | -400
CGM-YSI

(mg/dL)

>=40-60 546 0.0% 3/09'6 3;:5'8 (1,/03 7 09% | 0.0% | 0.0% | 0.0% | 0.0% | 0.0% | 0.0%

>80-120 1327 0.0% | 09% | 7.0% 05/09'8 3/01 2 1.1% | 0.1% | 0.0% | 0.0% | 0.0% | 0.0%

>160-200 | 1045 00% | 03% | 0.0% | 1.1% 3,/5'7 f/:"ﬁ 3,/09'3 07% | 0.1% | 02% | 0.0%

>250-300 | 584 00% | 0.0% | 0.0% | 0.0% | 0.9% | 55% l/f 0 05/06'0 (1/07 3 24% | 0.0%
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Table 14.The concurrence of YSI values and CGM readings using YSI glucose
ranges; Calibrating every 12 hours, Abdomen insertion site.

Table 15.The concurrence of CGM readings and YSI values using CGM glucose
ranges; Calibrating three to four times a day, Abdomen insertion site.

Ys

Glucose (’;"}‘g?reerd <40 | >=40 | >60- | >80- | >120 | >160 | >200 | >250 | >300 | >350 | _, o

Ranges 60 | 80 120 | -160 | -200 | -250 | -300 | -350 | -400
CGM-YSI

(mg/dL)

>60-80 892 0.0% 2611 60.3 123 1.2% | 0.0% | 0.0% | 0.0% | 0.0% | 0.0% | 0.0%

>120-160 | 1339 00% | 0.1% | 1.9% 3/09'7 2/08'0 83% | 20% | 0.0% | 0.0% | 0.0% | 0.1%

>200-250 | 811 0.0% | 00% | 0.0% | 0.4% | 3.7% 1.0% | 0.6% | 0.1%

>300-350 | 298 00% | 0.0% | 00% | 00% | 00% | 07% | 34% | 272 | 497 | 161 1 ;30
% % | %
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Table 16.The concurrence of CGM readings and YSI values using CGM glucose
ranges; Calibrating every 12 hours, Abdomen insertion site.

Ys

Glucose E‘f“{,’;?r‘zrd <40 | >=40 | >60- | >80- | >120 | >160 | >200 | >250 | >300 | >350 | _, o

Ranges 60 | 80 120 | -160 | -200 | 250 | -300 | -350 | -400
CGM-YSI

(mg/dL)

>60-80 983 0.0% 02/;5'4 2/04'9 95% | 0.1% | 0.0% | 0.1% | 0.0% | 0.0% | 0.0% | 0.0%

>120-160 | 1566 00% | 03% | 1.9% 3/06'4 05/06'1 (1/02 = 26% | 03% | 0.0% | 0.0% | 0.0%

>200-250 | 843 0.0% | 0.0% | 0.0% | 0.1% | 1.9% 240 39.1 12:5 1.7% | 06% | 0.2%
% % %

5300-350 | 345 0.0% | 0.0% | 0.0% | 0.0% | 03% | 03% | 2.6% 02/09‘3 2/3'7 3/05‘1 1.7%

Table 17. Ranges for every 2 hour post calibration period.

15001 68.90% 80.20% 91.70% 96.50% 3.50%
5320 69.20% 80.50% 91.60% 96.40% 3.60%

59.50% 73.60% 89.50% 93.10% 6.90%
10-12 hours 81.80% 90.90% 97.00% 97.00% 3.00%

Before

. . 12 50.00% 66.70% 83.30% 100.00% 0.00%
Calibration
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*For YSI reference range < 80 mg/dL, agreement was based on 15/20/30/40 mg/dL. For CGM reference
range < 80 mg/dL, agreement was based on 15/20/30/40 mg/dL.

Sensor life

After calibration, 83.2% of sensors operated more than five days and up to the full six days of wear
(120-144 hours).!

1 Medtronic Inc., A Performance Evaluation of the Enlite Glucose Sensor to Support a Full 144 hours (6 Days) of Use, CER247/

725/C, May 2012

Safety

There were no moderate or severe device-related or procedure related adverse events, device-related
or procedure-related serious adverse events, or unanticipated adverse device effects after six days
of use.

iPro2 CGM User Guide  Enlite Sensor Performance for the iPro2 88

P150029 PMA Final Labeling Amendment P150029
Medtronic Confidential 1-110



Specifications and notices

iPro2 system specifications

Atmospheric pressure range

iPro2: 57.6 kPa - 106 kPa (16,000 to -1,300 feet [4,880 to -400
meters] elevation)

Dock: 62 kPa - 106 kPa (13,000 to -1,300 feet [3,965 to -400
meters] elevation)

Applied Parts

iPro2 (MMT-7741)
Sensor (MMT-7008)

Biocompatibility

iPro2: Complies with ISO 10993-1 for long-term body contact

Operating Conditions

iPro2 temperature: +23 °F to +113 °F (-5 °C to 45 °C)

Caution: When the iPro2 is connected to the Dock in air
temperatures greater than 106°F (41°C), the temperature of the
iPro2 may exceed 109°F (43°C).

iPro2 relative humidity: 5% to 95% with no condensation
Dock temperature: +23 °F to +113 °F (-5 °C to +45 °C)

Dock relative humidity: 5% to 95% with no condensation

Storage Conditions

iPro2 temperature: -13 °F to +131 °F (-25 °C to +55 °C)
iPro2 relative humidity: 10% to 100% with condensation
Dock temperature: -13 °F to +131 °F (-25 °C to +55 °C)

Dock relative humidity: 10% to 100% with condensation

iPro2 Battery Life

7 days of continuous glucose monitoring (CGM) immediately
following a full charge, plus 10 days of additional battery life
immediately following a CGM study. Any data on the device will
be lost when the battery loses its charge.

iPro2 Dimensions and Weight

Width: 1.4 inches (3.5 centimeters)
Length: 1.1 inches (2.8 centimeters)
Height: 0.4 inches (0.9 centimeters)
Weight: 0.2 ounces (5.7 grams)

Dock Dimensions and Weight

Width: 2 inches (5.1 centimeters)
Length: 2.5 inches (6.4 centimeters)
Height: 1.1 inches (2.8 centimeters)
Weight: 0.8 ounces (22.7 grams)
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« The iPro2 is an internally powered device. The mode of operation is continuous. The iPro2 is

not suitable for use in the presence of a flammable anaesthetic mixture with air or with oxygen
or nitrous oxide.

«  All components of the iPro2 CGM system are suitable for use in a clinical environment. The iPro2
recorder is suitable for use with a glucose sensor in the patient environment.
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Guidance and manufacturer's declaration

Guidance and Manufacturer's Declaration - Electromagnetic Emissions

The iPro2 CGM system is intended for use in the electromagnetic environment specified below. The customer or
the user of the iPro2 CGM system should assure that it is used in such an environment.

IEC 61000-3-3

Emissions Test Compliance Electromagnetic Environment - Guidance
RF emissions Group 1 The iPro2 CGM system does not use RF energy for system
CISPR 11 communication functions.
RF emissions
Class B
CISPR 11
Harmonic emissions The iPro2 CGM system is suitable for use in all
Complies by establishments, including domestic establishments and
exemption those directly connected to the public low-voltage power
IEC 61000-3-2 . e :
supply network that supplies buildings used for domestic
Voltage fluctuations/flicker purposes.
emissions Complies by
exemption
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Guidance and Manufacturer's Declaration - Electromagnetic Immunity

The iPro2 CGM system is intended for use in the electromagnetic environment specified below. The customer or
the user of the iPro2 CGM system should assure that it is used in such an environment.

Immunity Test

IEC 60601 Test Level

Compliance Level

Electromagnetic
Environment - Guidance

Electrostatic discharge
(ESD)

+8 kV indirect

+8 kV, 30%-60%
relative humidity

Relative humidity should

+22 kV air be at least 5%.
IEC 61000-4-2 +8 kV air (<5% relative
humidity)
Electrical fast transient/ |i'2 kV for power supply +2 KV Mains power should be
urst ines that of a typical
; commercial or hospital
IEC 61000-4-4 ﬁrlwetv for input/output =1 kv environment.
Surge +1 kV line(s) to line(s) +1 kV Mains power should be
that of a typical
IEC 61000-4-5 +2 KV line(s) to earth +2 KV commercial or hospital
environment.
<5% Ut (>95% dip in Uy) <50 U Mains power should be
for 0.5 cycle oot that of a typical
commercial or hospital
) 40% Ut (60% dip in Uq) o environment. If the user of
YOItage (:jIpS, short for 5 cyc|es 40% UT the iPro2 CGM system
interruptions and voltage requires continued
variations on power supply | 70% Ut (30% dip in Uy) 20% U operation during power
lines for 25 cycles T mains interruptions, it is
IEC 61000-4-11 recommended that the
iPro2 CGM system be
<5% Ut (>95% dip in Uy) <5% U powered from
for 5 seconds T uninterruptible power
supply or battery.
Power frequency magnetic
Power frequency fields should be at levels
(50/60 Hz) magnetic field 30 A/m 30 A/m characteristic of a typical

IEC 61000-4-8

location in a typical
commercial or hospital
environment.

NOTE: Uy is the a.c. mains voltage prior to application of the test level.
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Guidance and Manufacturer's Declaration - Electromagnetic Immunity

The iPro2 CGM system is intended for use in the electromagnetic environment specified below. The customer or
user of the iPro2 CGM system should assure that it is used in such an environment.

Immunity Test IECI_:‘?SIN Compliance Level Electromagnetic Environment Guidance
Portable and mobile RF communications
equipment should be used no closer to any
part of the iPro2 CGM system, including
cables, than the recommended separation
distance calculated from the equation
applicable to the frequency of the transmitter.
Recommended separation distance:

Conducted RF 3 Vrms
150 kHz to 3 Vrms d=1.24/P
IEC 61000-4-6 80 MHz
d=1.24/P 80 MHz to 800 MHz
Radiated RF 3V/m
80 MHz to 3 V/m
IEC 61000-4-3 6.0 GHz d=2.3+4/P 800 MHz to 6.0 GHz

Where P is the maximum output power rating
of the transmitter in watts (W) according to
the transmitter manufacturer and d is the
recommended separation distance in meters
(m).

Field strengths from fixed RF transmitters, as
determined by an electromagnetic site
survey?, should be less than the compliance
level in each frequency rangeb.

Interference may occur in the vicinity of
equipment marked with the following
symbol:

()

NOTE 1: At 80 MHz and 800 MHz, the higher frequency range applies.

NOTE 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption, and
reflection from structures, objects and people.

a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land
mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically
with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site
survey should be considered. If the measured field strength in the location in which the iPro2 CGM system is
used exceeds the application RF compliance level above, the iPro2 CGM system should be observed to verify
normal operation. If abnormal performance is observed, additional measures may be necessary, such as re-
orienting or relocating the iPro2 CGM system.

b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
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Recommended separation distances between portable and mobile RF communications equipment and the
iPro2 CGM system

This section provides information on the recommended separation distance between portable and mobile RF
communications equipment and the iPro2 CGM system. The iPro2 CGM system is intended for use in an
electromagnetic environment in which radiated RF disturbances are controlled. The customer or users of the
iPro2 digital recorder can help prevent electromagnetic interference by maintaining a minimum distance between
portable and mobile RF communications equipment (transmitters) and the iPro2 digital recorder as recommended
below, according to the maximum output power of the communications equipment.

Separation distance according to the frequency of transmitter (m)
Rated maximum 150 kHz to 80 MHz 80 MHz to 800 MHz 800 MHz to 6.0 GHz
output power of
transmitter (W) d=1.24/P d=1.24/P d=23P
0.01 0.12 0.12 0.23
0.1 0.38 0.38 0.74
1 1.2 1.2 23
10 3.8 3.8 74
100 12 12 23

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in
meters (m) can be estimated using the equation applicable to the frequency of the transmitter, where p is the
maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer.

NOTE 1: At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.

NOTE 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption, and
reflection from structures, objects and people.
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Warranty

Medtronic Diabetes warrants the iPro2 and Dock to the purchaser of the product against defects in
material and workmanship for a period of one year from the date of purchase.

During the warranty period, Medtronic Diabetes will repair or replace, at its discretion, any defective
iPro2 or Dock, subject to the conditions and exclusions stated herein. This warranty applies only to
new devices. In the event a iPro2 or Dock is repaired or replaced, the warranty period will not be
extended past its original expiration date.

This warranty is valid only if the iPro2 or Dock is used in accordance with the manufacturer's
instructions. Without limitation, this warranty will not apply:

«  If damage results from changes or modifications made to the iPro2 or Dock by the user, or third
parties, after the date of sale;

« If service or repairs are performed by any person or entity other than the manufacturer;
«  If damage results from a Force Majeure or other event beyond the control of the manufacturer;

«  If damage results from negligence or improper use, including but not limited to: improper
storage, submersion in fluid, physical abuse (such as dropping); or

«  If fluid has entered the inside of the iPro2 connector opening or the Dock.

This warranty shall be personal to the original user. Any sale, rental or other transfer or use of the
product covered by this warranty to or by a user other than the original user shall cause this warranty
to immediately terminate. This warranty does not apply to glucose sensors and other accessories.

The remedies provided for in this warranty are the exclusive remedies available for any defects in

material or workmanship in the product. Neither Medtronic Diabetes nor its suppliers or distributors
shall be liable for any incidental, consequential, punitive or special damages of any nature or kind
caused by or arising out of a defect in the product.

All other warranties, expressed or implied, are excluded and specifically disclaimed, including, but
not limited to, any warranty of merchantability or fitness for a particular purpose.
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Icon table

Description

Icon

Follow instructions for use

Attention: Read all warnings and precautions in
instructions for use.

Stand-by power

Charging/uploading status

Date of manufacture (year - month)

Manufacturer

EEOOCB>I

Batch code

-
o
—

Catalogue number

s
m
T

Device serial number

pd

Configuration

Storage humidity range

Storage temperature range

Fragile product

S IESESIEND

Ingress protection safety rating. An object one
millimeter in diameter cannot penetrate the
device and cause harm to the user, property, or
the environment. This device can withstand
immersion under water for 30 minutes at a
depth of 8 feet (2.4 meters).

IP48

Type BF equipment (Protection from electrical
shock)

Recycle

One per container/package

Three per container/package

Keep dry
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MEDICAL EQUIPMENT WITH RESPECT TO
ELECTRICAL SHOCK, FIRE AND MECHANICAL
HAZARDS ONLY IN ACCORDANCE WITH UL
60601-1, CAN/CSA C22.2 No. 601 and IEC
60601-1-1.

Q\}SSIF/%
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Glossary

Area Under the Curve (AUC) - Indicates the amount in high and low excursions as determined by
preset values. Excursion data indicates the frequency of highs or lows. AUC indicates the
magnitude of events by showing how far out of range and for how long.

BG - Blood Glucose
BG reading - Blood glucose measurement that is taken by a blood glucose meter.
Calibrate - Check, adjust, or set to a standard. Sensor data is calibrated using BG meter readings.

Cleaning plug - Small plastic plug that you connect to the iPro2 before cleaning and disinfecting it.
The cleaning plug protects the iPro2's connector pins from being damaged by water or cleaning
fluids.

Docking Station (Dock) - Device that performs two functions: uploading glucose sensor data from an
iPro2 to CareLink iPro; and charging the iPro2. The Dock can be connected to a computer or to an
electrical socket.

iPro2 Recorder (iPro2) - Device that continuously records sensor glucose data while connected to a
glucose sensor. You can upload the data to CareLink iPro by connecting the iPro2 to a Dock, and
view the sensor data on reports.

Logbook - A screen in CareLink iPro that lets you manually enter events such as BG meter readings,
meals, exercise, and medication taken, so that these events show up on reports. The Logbook also
displays BG meter readings, and possibly other events, that you upload from a supported blood
glucose meter into CareLink iPro.

Mean Absolute Difference % (MAD%) - Represents the level of accuracy in calibration of the sensor
to BG meter readings. The lower this number, the greater the calibration accuracy. MAD% is
calculated by taking the difference between closely occurring pairs of sensor glucose and BG meter
readings, dividing by the BG meter reading, and then averaging across all pairs.

Mean Absolute Difference (MAD) - Represents the level of accuracy in calibration of the sensor to BG
meter readings. The lower this number, the greater the calibration accuracy. MAD is calculated by
taking the difference between closely occurring pairs of sensor glucose and BG meter readings and
then averaging across all pairs.

Meter - A medical device for determining the approximate concentration of glucose in the blood. A
small drop of blood is placed on a disposable test strip, which the meter reads and uses to calculate
the blood glucose level. The meter then displays the level in mg/dL or mmol/L.

Serter - The Serter is an aid for the insertion of a Medtronic Diabetes glucose sensor.
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Study - The period of time that a patient wears a glucose sensor and iPro2. This word also refers to an
upload of glucose sensor data from an iPro2 into CareLink iPro, along with any meter upload and
Logbook entries for that iPro2 upload. Each study has its own set of reports.

Upload - The process of transferring diabetes device data to the CareLink iPro server.
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Index

Numerics

24 Hour HelpLine 10

A

accessing
Logbook screen 47
accessing CarelLink iPro 17
accessing patient records 43
activating iPro2 11
activity, entering in Logbook 47
adding
CarelLink iPro users 18, 60
Logbook entries 47
administrative user
creating first 16
creating user accounts 18,60
deleting user accounts 61
modifying user accounts 60
tasks in CareLink iPro 60
alcohol wiping 27
area under the curve 54
assistance 10
attaching iPro2 to sensor 33
AUC 54

before connecting iPro2 33

BG meter
patient instructions 32

BG meter readings, excluding from

calibration 48

blood glucose meter
uploading data 46

blood glucose meter readings
entering in CareLink iPro 47

blood glucose meter use, patient
instructions 32

blood glucose meters
supported 7

briefing patient 31

browser
required settings 22
supported browsers 8

C

calibration, improving 48
care and wearing instructions 32
Carelink iPro
about uploading data 36
adding Logbook entries 47

changing password or user information 58

Data Table report 56

deleting user accounts 61
editing Logbook entries 48
editing patient information 58
entering blood glucose data 47
excluding BG meter readings 48
exporting data 56

meters supported 7

ongoing use, administrator tasks 60
ongoing use, user tasks 58
opening patient records 43
patient report settings 54
printing reports 51

removing Logbook entries 49
reports 50,52

restoring default patient report settings 55

signingin 17

software setup 15

sorting Logbook entries 49
tips for successful reports 51
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uploading data 44

uploading meter data 46

viewing reports 51
charging iPro2 64
cleaning

cleaning plug 63

Dock 63

iPro2 38,63

USB cable 63

wall-powered adapter 63
cleaning iPro2

about 63

before patient study 27
cleaning plug

about 2
clearing iPro2 data 76
clinic registration 16
clinic report settings 18
common tasks in CareLink iPro

administrator tasks 60

regular user tasks 58
compliance information 8
computer system requirements 8
connecting iPro2

preparing 33
connecting iPro2 to sensor 33
contraindications 4
correcting Logbook entries 48
creating

CSVfile 56

Data Table report 56

user accounts 17,18, 60
CSV file export 56

D

Daily Overlay report, about 52
Daily Summary report, about 52
daily use
common tasks in CareLink iPro 58
managing users in CareLink iPro 60
data
exporting to CSV 56
log sheets, entering 47
uploading blood glucose meter 46
uploading iPro2 44
Data Table report, generating 56
default report settings 18
deleting
user accounts 61
deleting Logbook entries 49
device setup, first time 11
devices that connect to iPro2 14
disconnecting iPro2 from patient 37
disinfecting iPro2 38,63

Dock
about 2
cleaning 63
lights, quick reference 75
watertightness 63
Dock lights
about 2

editing
CarelLink iPro users 60
Logbook entries 48
electromagnetic immunity 92
enrolling clinic 16
entering log sheet data 47
equipment log
printing new copies 25
using 31,44
erasing iPro2 data 76
Excel data export 56
excluding BG meter readings 48
exercise, entering in Logbook 47
exporting data 56

FAQs 67
Firefox
SSL, enabling 24
upgrading 24
first day of study 32
first patient visit 26
first time setup
device setup 11
software setup 15
flashing light 75
frequently asked questions 67

G
general report settings 19
generating
CSV file 56

Data Table report 56
generating reports

tips for success 51
glucose sensor

connecting iPro2 33

inserting 30
glucose units

system default setting 18
green light 75
guidance and manufacturer's declaration 91
guidelines for successful reports 51
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icons 96
indications for use 4
inserting sensor 30
installation of software 20
instructing patient 31
interference from wireless devices 10
Internet browser, required settings 22
Internet Explorer 23
enabling SSL 24
upgrading 24
iPro2
about 2
charging 64
cleaning and disinfecting 27, 38, 63
connecting to sensor 33
disconnecting from patient 37
preparing to connect to patient 33
removing from patient 37
resetting 76
setup, first time 11
system components 2
uploading data 44
iPro2 instructions
care and wearing instructions 32

J

Javainstallation 20
JavaScript, enabling 23

L
lights, quick reference 75
log sheets
entering data 47
Logbook

adding entries 47
editing entries 48
entering data 47
excluding BG meter readings 48
opening 47
removing entries 49
sorting entries 49
logging in to CareLink iPro 17

M

maintenance, system 62
meals, entering in Logbook 47
medication, entering in Logbook 47
meter
excluding meter readings 48
uploading data 46

meter use, patient instructions 32
meters
supported 7
modifying
clinic information 59
Logbook entries 48
patient report settings 54
user accounts 60
moving a patient study 59

notices
warranty 95

office registration 16
opening

Logbook screen 47

patient record 43
operating system requirements 8
optimal accuracy criteria 52
Overlay by Meal report

about 52

settings 19

P

password, CareLink iPro 58
patient

briefing 31

instructions 31

setup 26
patient information, editing 58
patient instructions

care and wearing 32

meter use, first day 32

meter use, remaining days 32
patient instructions sheet

printing new copies 25
patient log sheet

printing new copies 25
patient records

opening 43
patient report settings 54
patient return visit 36
patient study

moving a patient study 59

tips for success 28
precautions 5
preparing for patient study

about 27

wiping iPro2 with alcohol 27
preparing for sensor insertion 30
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preparing to connect iPro2 33
previewing reports 51
printing reports 51

Q

quick reference, Dock lights 75

R

red light 75
registering clinic 16
removing
CarelLink iPro users 61
iPro2 from patient 37
Logbook entries 49
sensor from patient 37
report settings
clinic 18
general 19
Overlay by Meal 19

restoring default, patient settings 55

reports
about 50, 52
area under the curve (AUC) 54
clinic report settings 18
CSV file 56
Daily Overlay 52
Daily Summary 52
Data Table 56
General Report Settings 19
optimal accuracy 52
Overlay by Meal 52
Overlay by Meal Report Settings 19
patient report settings 54
printing 51

restoring default patient report settings 55

tips for success 51
viewing 51

required browser settings 22
enabling JavaScript 23
SSL settings 23

reset button, key notes 14

resetting iPro2 76

resources, downloading and printing 25
restoring default patient report settings 55

S

Secure Sockets Layer (SSL)
required browser settings 23

sensor
connecting iPro2 33
inserting 30
removing from patient 37
uploading data 44

setting clinic report settings 18

setting up computers for uploading 20

setup
CareLink iPro software 15
clinic 16
computers for uploading 20
iPro2 recorder 11
patient 26
user accounts 17
signing in to CarelLink iPro 17
software drivers 20
software installation 20
software requirements 8
sorting Logbook entries 49
specifications 89
spreadsheet data export 56
storage and organization tips 65
study
preparing for 27
support, software requirements 8
supported blood glucose meters 7
symbols 96
system maintenance 62
system overview 2
system requirements, computer 8

T

target glucose range, setting system default 18

time display, setting system default 18
tips for patient studies 28
tips for storage and organization 65
tips for successful reports 51
troubleshooting

about 67

CarelLink iPro 71

connector pins 74

Data Table report 56

troubleshooting reference 67

U

upgrading Firefox 24
upgrading Internet Explorer 24
uploading

iPro2 data 44

meter data 46

supported meters 7
uploading data

about 36
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user accounts
creating 17, 18,60
deleting 61
modifying 60

user safety
about 4
contraindications 4
indications for use 4
precautions 5
warnings 4

\')

viewing
Logbook entries 49
patient reports 51

W

wall-powered adapter
about 2
warnings 4
warranty 95
watertightness
Dock 63
white light 75

wireless devices, interference 10
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Attachment 2



" ClinicChecklist &

Patient Name:

Patient Setup

NOTE: For complete instructions, go to http://www.carelinkipro.com and click the User Guide hyperlink.
Follow cleaning and disinfection instructions to ensure that your iPro2 has been properly cleaned and disinfected.

Materials needed for patient setup

iPro2

Patient Log Sheets

Patient Consent Form
Patient Instructions Sheet
Clinic Equipment Log
Occlusive adhesive dressing

Gloves

Alcohol swabs

Sensor insertion device
Glucose sensor

Sharps container
Cleaning plug

oo odod
oo 0dod

Prepare iPro2

1 Preparation of iPro2 should only begin after the iPro2 has been properly cleaned and disinfected.

(1 Verify iPro2 is ready to use. Check for solid green charging light on Dock. Flashing green charging light may mean:
® iPro2 contains patient data and needs to be uploaded before it can be used on another patient, or
® iPro2 needs to finish charging before it can be used.

If you see a red warning light on the Dock, do not connect the iPro2 to a sensor on a patient. See the Troubleshooting
section in the User Guide.

(4 CleaniPro2:
(1 Remove iPro2 from the Dock and connect a cleaning plug.
[  Wipe iPro2 with alcohol swab. Disconnect cleaning plug.

Wash hands and put on gloves.

The sensor has been approved for use in the abdomen. Select an insertion site in this part of the body.
Clean insertion site with alcohol.

Insert sensor using the sensor insertion device.

Hold sensor in place while gently removing introducer needle. Dispose in sharps container.

Apply overtape as shown in the sensor insertion device user guide before connecting the iPro2.

[ I I Iy Ty I N

Enter the iPro2 serial number and blood glucose meter ID on the Clinic Equipment Log and on the Patient Log Sheet.

ConnectiPro2

Caution: If you see body fluid on the metal sensor contacts or black o-rings, do not connect the iPro2. Remove and
dispose of the sensor, and insert a new sensor. This will prevent contamination of the iPro2.

[d Train patient using Patient Instructions sheet.

[d Connect iPro2 to sensor. Avoid twisting.

(d Verify that iPro2 flashes briefly. If iPro2 does not flash within 20 seconds, disconnect from sensor and try again.
1 Apply adhesive tab to iPro2.

Clinician Signature: Date:
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Patient Name:

Disinfecting iPro2 and Uploading to CareLink® iPro

NOTE: For complete instructions, go to http://www.carelinkipro.com and click the User Guide hyperlink.

Materials needed for disinfecting and uploading

Gloves Gauze pad or cloth

iPro2 (which has been worn by the patient) 70% isopropyl alcohol

Bio-waste container Clinic Equipment Log

Cleaning plug Dock, connected to a computer
Optional: adhesive remover, such as Detachol® Patient’s blood glucose (BG) meter
Enzymatic Detergent Patient Log Sheet

Soft-bristled brush Meter manufacturer’s cable
Bleach

Inspect, clean, and disinfect iPro2

INSPECT [ Wash hands and put on gloves.

(d Remove iPro2 from sensor. Avoid twisting.

1 Remove sensor from patient’s body and dispose in bio-waste container.

[ Inspect the inside of the iPro2 connector opening for body fluid. Warning: If you see body fluid in the
connector opening, you must dispose of the iPro2 after completing the disinfection process. Do not
connect it to the Dock. See the User Guide for complete instructions.

(1 Connect a cleaning plug to the iPro2.

(1 Remove adhesive residue using adhesive remover (Detachol).

1 Rinse the iPro2 under cool tap water for at least one minute.

(d Prepare Enzymatic Detergent solution*. With cleaning plug still attached, fully submerge the iPro2 in the

a

a

Qa

oldoododo
oodooodd

CLEAN

detergent solution for at least one minute.
Remove the iPro2 from the solution, and brush the entire surface of the iPro2.
Rinse the iPro2 with cool tap water and then dry with a clean, dry cloth.
Prepare a 1:10 bleach solution** by using one (1) part 6% bleach to nine (9) parts water, for a final
concentration of 0.6%. Make sure to prepare a fresh solution for each use. With cleaning plug still attached,
soak the iPro2 in the bleach solution for 30 minutes.
Rinse the iPro2 under cool tap water for at least three minutes.
Wipe with 70% isopropyl alcohol.
Disconnect cleaning plug and inspect the iPro2 housing for any signs of cracking, discoloration, or
damage. Warning: Cracking, flaking, or damage of the housing are signs of deterioration and the
performance of the device may be compromised. This may affect the ability to properly clean
and disinfect the iPro2. If these signs are noted, the device must be discarded according to local
regulations for battery disposal (non-incineration).

(1 Allow the iPro2 to air dry. Discard used gloves.
*Cleaning efficacy testing and robustness testing were conducted on the iPro2 using ENZOL® Enzymatic Detergent. Robustness testing for
the iPro2 included a contact time of one minute per cycle for 61 cycles, which is equivalent to cleaning every three days for six months.
** Disinfecting efficacy testing and robustness testing were conducted on the iPro2 using Clorox® Regular Bleach (EPA registration number
5813-50, distributed by The Clorox Company). Robustness testing for the iPro2 included a contact time of 30 minutes per cycle for 61 cycles,
which is equivalent to cleaning every three days for six months.

Upload data and generate reports (on computer)

1 Find the patient’s record in CareLink iPro (http://www.carelinkipro.com) or create a new patient record if needed.

DISINFECT

oo

Use the Clinic Equipment Log or Patient Log Sheet to identify the correct iPro2 for the patient.
Click Upload iPro2. Follow on-screen instructions for uploading data from iPro2 and BG meter.
Click Open Logbook to add event markers or BG meter readings from Patient Log Sheets.

oo od

Click individual reports to view them, or click Print all to print them.

Clinician Signature: Date:
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Attachment 3



_ patient Instructions

Simple tips, instructions and guidelines for iPro2 use

Blood glucose (BG) testing

On the first day:

= Take your first BG meter reading at least 1 hour after you leave the physician’s office.

= Take a second BG meter reading at least 3 hours after you leave the physician’s office.

= Collect at least one more meter reading before going to bed.

Collect at least 4 BG meter readings each day, such as before breakfast, lunch, dinner, and bedtime.

Do not change any settings on your meter during the study, even if a daylight savings time change occurs.
Use the same blood glucose meter for all BG meter readings.

Do not let anyone else use your meter during the study.

Do not use control solution during the study.

Log sheet entries

Write down your BG meter readings, food or drink and number of carbohydrates, physical activity and
duration, medications and dosages, and other events (such as feeling hypoglycemic, stress, or illness).

Keep the log sheet with you at all times so you can write down the information immediately after each event.
Record the time and date within 5 minutes of each BG meter reading.

Care and wearing

Live your life with your normal behaviors. If you normally exercise, then exercise.

Keep tape over the sensor and iPro2 to prevent accidental removal or sensor movement. If the sensor comes
out even a small amount, it may stop working. If new tape is needed, just put it over the existing tape. If the
sensor comes out, place the sensor and iPro2 into a plastic resealable bag and notify your physician’s office.

Check the site 4 times a day to ensure that the sensor and iPro2 are firmly connected, the sensor is still fully
inserted, and there is no bleeding or irritation.

If the sensor is partly pulled out, attempt to gently push it back into place.

Remove the sensor if you have redness, pain, tenderness, or swelling at the site, and notify your physician’s
office.

You may shower and swim while wearing the iPro2 and sensor. The iPro2 is watertight at a depth of up to
2.4 meters (8 feet) for 30 minutes. There is no time limit if you are swimming on the surface of a pool or
showering.

Insulin should be injected at least 7.5 centimeters (3 inches) away from the sensor insertion site, and insulin
pump infusion should be at least 5 centimeters (2 inches) from the sensor insertion site.

The iPro2 and sensor must be removed prior to an x-ray, CT scan or MRI.
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